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                  ! WARNING !

- DO NOT proceed before reading -

This manual must be carefully read by all
individuals who have or will have the responsibility
for using, maintaining, or servicing this product.     
The product will perform as designed only if it is used,
maintained, and serviced in accordance with the
manufacturer's instructions.

                              CAUTION!!
To reduce the risk of electric shock, turn off power
before removing the monitor cover.  Disconnect the
battery before removing sensor module for service.
Never operate the monitor while the cover is
removed.  Remove monitor cover and sensor
module only in an area known to be non-hazardous.

The model PGM-50 equipment is classified as to
intrinsic safety for use in class I, division 1, groups
A, B, C, D, or non-hazardous locations only.
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Special Note

-1-
When the PGM-50 Multi-gas Monitor is taken out from
the transport case and turned on for the first time, there
may be some residual organic or inorganic vapor
trapped inside the detector chamber.  The initial PID or
toxic sensor reading may indicate a few ppm.  Ensure an
area free of  organic or toxic vapor and turn on the
monitor.  After running for several minutes, the residual
vapor in the detector chamber will be cleared and the
reading should return to zero.

-2-
The battery of the MultiRAE PLUS monitor will
discharge slowly even if it is turned off.  If the monitor
has not been charged for 5-7 days, the battery voltage
will be low.  Therefore, it is a good practice to always
charge the monitor before using it.  It is also
recommended to fully charge the monitor for AT
LEAST 10 HOURS before initial use (see Section 7  for
more information on battery charging and
replacement).
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WARNINGS:
Use only RAE Systems battery packs, part Nos.

500-0028, 500-0029, or 500-0039.  This instrument
has not been tested in an explosive gas/air

atmosphere having an oxygen concentration
greater than 21%.  Substitution of components
may impair intrinsic safety.  Recharge batteries

only in non-hazardous locations.

AVERTISSEMENT:
Utiliser seulement l'ensemble de batterie RAE

Systems, la reference 500-0028, 500-0029 au 500-
0039.  Cet instrument n’a pas été essayé dans une

atmosphère de gaz/air explosive ayant une
concentration d’oxygène plus élevée que 21%.  La
substitution de composants puet compromettre la
sécurité intrinsique.  Ne charger les batteries que
dans emplacements désignés non dangereuse.

STATIC HAZARD:
Clean only with a damp cloth.

DANGER RISQUE D'ORIGINE
ELECTROSTATIQUE:

Nettoyer uniquement avec un chiffon humide.
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CAUTION:
For safety reasons this equipment must be

operated and serviced by qualified personnel only.
Read and understand instruction manual
completely before operating or servicing.

ATTENTION:
Pour des raisons de sécurité, cet équipment doit

être utilisé, entretenu et réparé uniquement par un
personnel qualifié.  Étudier le manuel

d’instructions en entier avant d’utiliser,
d’entretenir ou de réparer l’équipement.
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CAUTION:
Before each day’s usage, sensitivity must be

tested on a known concentration of methane gas
equivalent to 20-50% of full scale concentration.

Accuracy must be within 0 to +20% of actual.
Accuracy may be corrected by calibration.

ATTENTION:
Avant chaque utilisation journalière verifier la
sensibilité avec une concentration connue de
methane equivalente a 20 - 50% de la pleine

échelle.  La précision doit être comprise entre 0 -
20% de la valeur vraie et peut être corrigée par une

procédure diétalonnage.

CAUTION:
Any rapid up-scale reading followed by a declining

or erratic reading may indicate a gas
concentration beyond upper scale limit which may

be hazardous.

ATTENTION:
Toute lecture rapide et positive, suivie d’une
baisse subite au erratique de la valeur, peut

indiquer une concentration de gaz hors gamme de
détection qui peut être dangereux.
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WARNING:
The calibration of all newly purchased RAE
Systems instruments should be tested by

exposing the sensor(s) to known concentration
calibration gas before the instrument is used or

put into service.

For maximum safety, the accuracy of the MultiRAE
PLUS should be checked by exposing the

sensor(s) to known concentration calibration gas
before each day’s use.

AVERTISSEMENT:
La calibration de toute instruments de RAE

Systems doivent être testé en exposant
l’instrument a une concentration de gaz connue
par une procédure diétalonnage avant de mettre

en service l’instrument pour la première fois.

Pour une securite maximale, la sensibilité du
MultiRAE PLUS doit être verifier en exposant

l’instrument a une concentration de gaz connue
par une procédure diétalonnage avant chaque

utilisation journalière.
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1.  GENERAL INFORMATION

MultiRAE PLUS is a programmable Multi-gas monitor
designed to provide continuous exposure monitoring of
toxic gases, oxygen and combustible gases for workers in
hazardous environments.  It monitors three classes of
hazardous gases:
(1) Organic vapors in the ppm range with the supplied

Photo-Ionization Detector (PID) using a 9.8, 10.6
eV or 11.7 eV gas discharge lamp,

(2) Combustible gases near their lower explosive limits
(LEL) with a catalytic bead sensor, and

(3) Inorganic compounds, including oxygen deficiency,
with the electrochemical sensors.

Other features include:

• Lightweight and Compact
- 16 oz (454 g), Walkman size.

• Dependable and Accurate
- 10 hours monitoring with micro controller.

• User Friendly
- menu driven, intuitive end-use operation.

• Programmable Alarm Thresholds
- audio buzzer & flashing display alarm.

MultiRAE PLUS (PGM-50) consists of:  A Multi-gas
Monitor, a battery charger, rubber boot, alkaline battery
adapter, water and dust filters, plus calibration accessories.
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1.1 General Specifications
Table 1.1

Multi-Gas Monitor Specification
Dimensions: 4.65”L x 3.0”W x 1.9”H

(11.8 cm x 7.6 cm x 4.8 cm)

Weight: 16 oz (454 g) with battery.

Detector: Up to five sensors (oxygen, combustible,
two toxic and VOC). Electrochemical
sensors for toxic gases and oxygen,
photo-ionization detector for ppm level
VOCs, and catalytic sensor for LEL level
combustible gases.

Battery: Rechargeable, 4.8V/1100 mAh Li ion or
4.8V/1700 mAh Ni-Cd battery pack with
built-in charger  (10 hours charge time) or
a 4 AA alkaline battery adapter.

Operating Time: Up to 10 hours continuous operation.

Display: 2 line, 16 digit LCD with LED back light
automatically in dim light.

Key-pads: 1 operation key and 2 programming keys.

Direct Readout: Instantaneous values (up to 5), sensor
name, high and low values for all
detectors, TWA and STEL values for
toxic and VOCs, battery voltage and
elapsed time.

                                 (Continued)
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Multi-Gas Monitor Specification
                                  (Continued)
Alarm Settings: Separate alarm limit settings for TWA,

STEL, Low and High alarm.
Range, Resolution and Response Time (t90 diffusion):

CO 0-500 ppm 1 ppm     20 sec
H2S 0-100 ppm 1 ppm     30 sec
SO2 0-20 ppm      0.1 ppm   15 sec
NO 0-250 ppm 1 ppm     20 sec
NO2 0-20 ppm      0.1 ppm   25 sec
Cl2 0-10 ppm      0.1 ppm   60 sec
O2 0-30 %          0.1 %     15 sec
VOC 0-200 ppm    0.1 ppm   10 sec
VOC 200-2000 ppm 1 ppm   10 sec
LEL 0-100 % 1 %     15 sec
HCN 0-100 ppm 1 ppm     60 sec
NH3 0-50 ppm 1 ppm   150 sec
PH3 0-5 ppm       0.1 ppm    60 sec

Alarm: 90 dB buzzer and flashing red LED to
indicate exceeded preset limits, low
battery, or sensor failure.

Calibration: Two point field calibration for fresh air
and standard reference gases.

Attachment: Rubber boot, wrist strap, belt clip.

Sampling Pump: Internal integrated with 300 cc/min flow
rate (high setting).

Protection: Password protected calibration settings,
alarm limits, and data.
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Multi-Gas Monitor Specification
(continued)

Intrinsic Safety: UL & cUL Class 1, Division I, Group
A,B,C,D (US & Canada), EEx ia IIC T4
(Europe).

EM Immunity: No effect when exposed to 0.43 mW /cm2
RF interference (5 watt  transmitter at 12
inches).

Data Storage: 20,000 readings (64 hours, 5 channels at 1
minute interval) in non-volatile memory.

Datalog Interval: Programmable 1- 3600 sec.

External Alarm: Optional plug in pen size vibration alarm
or earphone.

Communication: Upload data to PC and Download monitor
setup from PC through RS-232 link to
serial port on PC.

Temperature: -20o to 45oC (-4o to 113o F).

Humidity: 0 % to 95% relative humidity.
(non-condensing)

Configuration: 2, 3, 4 and 5 gas with / without pump
and with / without datalogging.
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2. OPERATION OF MULTIRAE PLUS

The MultiRAE PLUS Monitor gives real time
measurements and activates alarm signals whenever the
exposure exceeds preset limits on any of the five possible
sensors.  Prior to factory shipment, the MultiRAE PLUS is
pre-set with default alarm limits and the sensors are pre-
calibrated with standard calibration gas. However, the user
should calibrate the instrument before the first use.  After
the monitor is fully charged and calibrated, it is ready for
immediate operation.
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2.1 Physical Description

Figure 2-1 shows the main components of the MultiRAE
PLUS Multi-gas Monitor which include:

Figure 2-1   Major parts of the MultiRAE PLUS
         Multi-gas Monitor

• 3 keys for the user to interact with the monitor:  1
operation key and 2 programming keys for normal
operation or programming of the monitor.

• LCD display with back light to show real time and
calculated measurements.

Gas Inlet and Filter Buzzer &
Gas Outlet

Charge Contact

Serial Port for PC
Communication

Wrist Strap

Programming Keys

LCD Display

LED Alarm
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• Buzzer and red LED for alarm signal whenever the
exposures exceed preset limits and for error
conditions.

• Wrist strap.

• Charge contact for plugging directly to the charging
station.

•••• Gas entry port.

•••• Serial communication port for PC interface.
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2.2 Keys and Display

Figure 2-2 shows the LCD display and the keypad on the
front panel of the monitor.  The functions of the 3 keys
during normal operation are summarized in Table 2.1 on
the next page:

Figure 2-2 Key-pad and Display of the MultiRAE PLUS
Multi-gas Monitor

Light
sensor

0.1 0.0
0.0

0.0
20.9

MODE

ON

Y/+ N/-

OXY

TOX2VOC

LEL

TOX1

LED alarm/
charge status

[Mode]
key[Y/+] Key [N/-] Key
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Table 2.1
Key Function in Normal Operation

[MODE]: Turn on/off the power* and choose
  different display mode.

[N/-]: Toggle on/off the back light.  Answer as
“No.”

[Y/+]: Alarm test and alarm acknowledgment
(turn off latched alarm, turn on pump or
 LEL sensor). Answer as “Yes.”

* Pressing and holding [MODE] key for 5 seconds turns off
the power to the monitor.  Monitor will beep once per
second during power-down sequence.  Press [MODE] key
momentarily to choose different display modes (see
Section 2.4 for details).
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The Multi-gas Monitor includes a 2-line, 16-digit dot
matrix LCD display.  The LCD shows the following eight
types of displays during normal operation if the [MODE]
key is pressed:

• Real time instantaneous gas concentration in ppm
for toxic and VOC gases, % by volume for oxygen
and % LEL for combustible gases.

• Sensor names.

• Peak and minimum gas concentration for toxic,
VOC, oxygen and combustible gases.

• 15 minute Short Term Exposure Level (STEL)
values of the toxic and VOC gases in ppm and 8
hours Time Weighted Average (TWA).

• Battery voltage and shut off voltage in volts.

• Real time clock, run time and temperature.

• Datalogging mode or “Start / Stop Datalog?” menu
to enable/disable datalogging if manual datalogging
mode is selected.

• LEL or VOC gas names (if the LEL and VOC
sensor are installed).

• “Print Reading?” menu to print the reading to the
RAE Printer.

• “Communicate with PC?” menu to send or receive
data between PC and the MultiRAE PLUS monitor.
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2.3 Power On/Off

To turn on the MultiRAE PLUS Multi-gas Monitor, press
[MODE] key.  The audio buzzer will beep once and the
display will show “ON!..” and then “MultiGas Monitor
Ver n.nn” to indicate the software version number.  The
custom power-on-name which can be changed by the
customer using the ProRAE Suite Software. The model
number, serial number, current date and time, temperature
of the monitor are displayed next.  The monitor will then
go through each sensor socket to check if a valid sensor is
installed.  If a new sensor is installed, a message to remind
the user to calibrate the sensor will be displayed followed
by a message that the alarm limits have been reset to
default values for the new sensor.  If a sensor reaches its
expected end of life, a “Warranty Expired” message will be
displayed.

Next, the monitor displays the preset alarm limits for each
sensor, battery voltage, shut off voltage, user mode, alarm
mode, datalog mode, available data storage memory (in
hours), datalog mode and datalog interval (in seconds) and
then after 10 seconds, the display shows the instantaneous
reading of the gas concentration in ppm and is ready to
monitor gases.

To turn off the MultiRAE PLUS Multi-gas Monitor, press
and hold the [MODE] key for 5 seconds.  Monitor will beep
once per second during power-down sequence with a count
down timer showing the number of remaining seconds.
The message “Off!..” flashes on the LCD display and the
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display will go blank, indicating that the monitor is turned
off.

Turning off the Multi-gas monitor with the AC charger in
place will result in a display of “Charging..” or “Battery
Charged” and indication of battery voltage.  This indicates
that the monitor is off, but the smart charger circuit is now
active.

To turn the unit on from the charge or discharge mode,
press the [MODE] key.

Data protection during power off
When the monitor is turned off, all the current real time
data including TWA, STEL, Peak and elapsed time are
erased.  However, the datalog data is preserved in non-
volatile memory.  Even if the battery is disconnected, the
datalog data will not be lost.  During the power off period,
the real time clock will continue to operate until the battery
is completely drained (usually in 5-7 days without any
charging).  If the battery is completely drained or is
disconnected from the monitor for more than 30 minutes,
the real time clock will be lost.  In this case, users need to
enter the real time clock information again, as described in
Section 4.



OPERATION OF MULTIRAE PLUS

2 - 9

Datalog versus Non Datalog monitor
There are two versions of the PGM-50 Multi-gas Monitors:
Datalog monitors and Non-Datalog monitors.  During
power on sequence, a letter “D” following the version
number indicates that the monitor is configured as a
Datalog monitor.  Without the letter “D”, it is a Non-
Datalog monitor.

Users can upgrade a Non-Datalog monitor to a Datalog
monitor.  Call the factory for information on how to order
the upgrade kit and follow the instructions described in
Section 5.7 to enable or disable the datalog feature for the
monitor.
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2.4 Operation

The MultiRAE PLUS Multi-gas Monitor offers three
different user modes of operation:

Text mode,
Display mode, and
Programming mode (default mode setting).

The text mode is the simplest mode of operation.  The
monitor will display the sensor name after the monitor is
turned on.  The user can press the [MODE] key to see the
instantaneous gas concentration reading, battery voltage or
enter the PC communication menu.  The user can get into
the calibration mode from text mode to do calibrations, but
cannot change most of the parameters.

In the display mode, the MultiRAE PLUS Multi-gas
Monitor is able to display all the information in the text
mode.  In addition, the following information is also
available by pressing the [MODE] key: peak, minimum,
STEL, TWA, run time in hours and minutes, temperature
in degree C, datalog mode (or enable / disable datalogging
operation in manual datalog mode), LEL/VOC gas names,
printing and communication with a PC options. The user
cannot get into the calibration mode from display mode, so
the user cannot do calibration and cannot change any of the
parameters.

In the programming mode, which is the default setting,
the user can perform all of the functions of the display
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mode.  In addition, the user can get into calibration mode,
perform calibrations and change any of the parameter in the
calibration mode.

The following is the detail explanation of the displays
when the [MODE] key is pressed

1) The instantaneous reading is the actual gas
concentration in parts per million (ppm) for toxic or
VOC gases, % of volume for oxygen and % of LEL for
combustible gases.  The reading is updated once per
second and is shown in the LCD display.

TOX1               VOC TOX2

   0       0.0      0
   0   20.9

LEL      OXY

2) The sensor names are displayed as:
LEL:  for combustible gas sensor
VOC:  for PID sensor
OXY:  for oxygen sensor
CO, H2S, etc.:  for up to 2 toxic sensors

TOX1               VOC TOX2

CO      VOC H2S
LEL   OXY

LEL      OXY
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3) The Peak reading is the highest reading of each gas
concentration since the monitor was turned on.  The
reading is updated at one-second intervals and is
shown in the LCD display with “Peak” message.

TOX1               VOC TOX2

   5       2.0      3
 10     Peak 20.9

LEL      OXY

4)  The Minimum reading is the lowest reading of each
gas concentration since the monitor was turned on.  The
reading is updated at one-second intervals and is shown
in the LCD display with “Min” message.

TOX1               VOC TOX2

   0       0.0      0
   0       Min 19.9

LEL      OXY

5)  The STEL reading is the last 15 minute average reading
of the gas concentration.  The reading is updated once
per minute and is shown in the LCD display with
“STEL” message.  For the first 15 minutes,  “****” will
be displayed.  This reading applies to VOC and toxic
gases only.

TOX1               VOC TOX2

   0       0.0      0
    STEL

LEL      OXY
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6)  The TWA reading is the accumulated reading of the gas
concentration divided by 8 hours since the monitor was
turned on.  The reading is updated once a minute and is
shown in the LCD display with “TWA” message.  This
reading applies to VOC and toxic gases only.

TOX1               VOC TOX2

   0       0.0      0
    TWA

LEL      OXY

7) The battery voltage reading is the current battery
voltage in volts.  The reading is updated once per
second and is shown in the LCD display.  The shut
down voltage is also shown.  Note:  A fully charged
battery pack should show 4.8 volts or higher.  When
the battery voltage falls below 4.4 volts, a flashing
“Bat” will appear as a warning message.  This means
there is 20-30 minutes run time left before the monitor
will be turned off automatically, when the battery
voltage falls below 4.2 volts.

TOX1               VOC TOX2

Battery = 4.8 V
Shut down at 4.2 V

LEL      OXY
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8) The run time reading is the accumulated “On” time in
hours and minutes since the monitor was turned on.
The reading is updated at one minute intervals and is
shown in the LCD display together with the current
date, time and temperature.

TOX1               VOC TOX2

  8/3/96          8:30
On = 3:50            20°°°°C

LEL      OXY

9)   The datalog menu shows the current datalog mode.  If
manual datalog mode is selected, the menu will prompt
the user to turn on or off datalogging.  Pressing the
[Y/+] key while “Start Datalog?” message is displayed
turns on the datalogging.  Likewise, pressing the [Y/+]
key while “Stop Datalog?” message is displayed turns
off the datalogging.

10) The monitor will display the selected LEL and VOC
gas name if the combustible sensor and PID sensor are
installed.  When an LEL or VOC gas is selected, the
“calculated” gas concentration based on the built-in
correction factor for that specific gas will be displayed.

11) Print Reading? asks for printing out of the gas
concentration reading. If a serial printer is connected
and ready, pressing the [Y/+] key will print out the
reading.
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12) The Communicate with PC? menu allows the user
to upload data from the MultiRAE PLUS to a Personal
Computer (PC) or download configuration information
from a PC to the MultiRAE PLUS.  Press the [Y/+] key
and the LCD displays the message “Monitor will pause,
OK?” to remind the users that during PC
communication, there will be no real time monitoring of
the gas concentration.  Press [Y/+] to proceed and the
monitor enters the communication standby mode.  The
LCD then displays “Ready...”  Connect the monitor to
the serial port of a PC.  The monitor is then ready to
receive any command from a PC (see Section 5 for
details on communications between the MultiRAE
PLUS and a PC).

Note:  When the monitor is in communication
standby mode, it stops monitoring the gas
concentration and stops the datalogging.
Datalogging must be manually restarted when
exiting the communication standby mode, unless
it is in automatic datalogging mode.

Displays in text mode:
The four displays are arranged in a “round robin” order:

Sensor name

PC comm?

Instantaneous
reading

Battery voltage
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Displays in display or program mode:
The twelve displays are arranged in a “round robin” order:

To choose a specific display, press the [MODE] key one or
more times until the desired display appears.

Display time out
In all displays, the LCD will automatically return to the
instantaneous reading (in display or program mode) or
sensor name (in text mode) after a one-minute time out
interval if no key is pressed.

Run time/clock

Instantaneous
Reading

Min. value

PC comm? Peak value

LEL/VOC gas STEL value

Sensor name

Start/stop datalog?

Battery voltage

TWA value

Print Reading?
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2.5 Alarm Signals

The built-in microcomputer updates the gas concentrations
every second and compares them with the programmed
alarm limits (TWA, STEL, and two instantaneous gas
concentration alarm limit settings:  Low & High).
Whenever the concentration exceeds the sensors’ preset
limits, the loud buzzer and red flashing LED are activated
immediately to warn the user of the alarm condition.

In addition, the MultiRAE PLUS will alarm if one of the
following conditions occurs: battery voltage falls below a
pre-set level (4.4 V), failure of the UV lamp, LEL sensor
off, pump stall or when the datalog memory is full.  When
the low battery alarm occurs, there will be approximately
20-30 minutes of operating time remaining.  When the
battery voltage falls below 4.2 V, the monitor will be
turned off automatically.

Alarm Signal Disabled: It is extremely important
to note that during the following conditions, the
alarm signals are disabled:
1)   In PC communication standby mode.
2) In calibration mode (including reviewing
datalog data).

During these modes of operation, real time monitoring of
the gas concentration stops.  None of the gas concentrations
will be calculated, including Peak, STEL and TWA.
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Alarm Signal Latching:
It is possible to setup the MultiRAE PLUS from a PC or in
programming mode so that when an alarm condition
occurs, the alarm signals stay on even after the alarm
condition is no longer present.  This is called the “latching
alarm” mode.  The alternative mode is to automatically
reset the alarm signal when the alarm condition is cleared.
The default alarm mode is automatic reset (see Chapter 4
or 5 for details on how to set alarm mode).

Alarm Signal Summary:
The various alarm signals are summarized here:

Condition Alarm Signal
Gas exceeds “High
Alarm” limit

3 beeps/flashes per second
plus sensor name on LCD

Gas exceeds “Low
Alarm” limit

2 beeps/flashes per second
plus sensor name on LCD

Gas exceeds STEL 1 beep/flash per second plus
sensor name on LCD

Gas exceeds TWA 1 beep/flash per second plus
sensor name on LCD

Negative Drift or
Over Range

3 beeps/flashes per second
plus NEG or OVR name on
LCD

Pump failure 3 beeps/flash per second plus
“Pump” message on LCD

LEL sensor off 3 beeps/flash per second plus
LEL sensor name and “Off”
message on LCD
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PID lamp failure 3 beeps/flash per second plus
“Lamp” message on LCD

Low battery 1 flash per second, 1 beep per
minute plus “Bat” message on
LCD

Memory full 1 flash per second plus
“Mem” message on LCD

Alarm Signal Testing:
Under normal non-alarm conditions, it is possible to test
the MultiRAE PLUS LED, buzzer and back light by
pressing the [Y/+] key momentarily.  The buzzer will beep
once and the LED and back light will flash once to indicate
that these alarm signals are functioning correctly.

WARNING:
The alarm signals are disabled during PC
communication, calibration or datalog review
operation.  To reduce the risk of exposure to
hazardous atmospheres, perform PC
communication, calibration or datalog review only
in area known to be non hazardous.
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2.6 Back Light

The LCD display is equipped with an LED back light to
assist in reading the display under poor lighting conditions.
This back light can be turned on manually by pressing and
holding the [N/-] key for one second in normal operation.
The back light can be turned off by pressing [N/-] a second
time.  If the [N/-] key is not pressed, the back light will be
turned off automatically after a pre-programmed time-out
period to save power.

In automatic mode, the ambient light is sensed and the back
light will be turned on automatically if the ambient light is
below a threshold level.  The back light will be turned off
automatically when the ambient light exceeds the threshold
level.

(See Chapter 4 or 5 for details on how to set back light
mode and time out period from the monitor or from PC.
See Chapter 8 for details on how to set the ambient light
threshold level.)

Note:  The LED back light consumes a higher amount of
energy from the battery and shortens the operating time of
the monitor by 20 - 30%.
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2.7 Preset Alarm Limits and Calibration

The MultiRAE PLUS Multi-gas Monitor is factory
calibrated with standard calibration gas, and is
programmed with default alarm limits as listed below.
(refer to Chapter 4 or Chapter 5 for programming
procedures if new calibration or alarm limits is required).

Table 2.2
Factory Calibration and Preset Alarm Limits
Gas
ppm

Cal Gas /
Balance

Unit TWA STEL Low High

CO 50 / Air ppm 35 100 35 200
H2S 25 / N2 ppm 10 15 10 20
SO2 5 / N2 ppm 2 5 2 10
NO 25 / N2 ppm 25 25 25 50
NO2 5 / Air ppm 1 1 1 10
Cl2 10 / N2 ppm 0.5 1 0.5 5
O2 20.9 / N2 %Vol - - 19.5 23.5
CH4 50 / Air %LEL - - 10 20
HCN 10 / N2 ppm 5 5 5 50
NH3 50 / N2 ppm 25 35 25 50
PH3 5 / N2 ppm 0.3 1 1 2
VOC* 100 / Air ppm 10.0 25.0 50.0 100

*Note:  100 ppm isobutylene gas is used for VOC gas            

              calibration
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2.8 Integrated Sampling Pump

The MultiRAE PLUS Multi-gas Monitor includes an
integrated sampling pump.  This is a diaphragm pump
providing about 300 cc per minute flow rate at the high
setting with the standard filters in place.

A low pump speed of about 200 cc per minute is the
factory default setting, which will increase the battery life
by about 5% and result in an increased LEL sensor lifetime
(see Chapter 4 or 5 for details of how to select the pump
speed).

The high pump speed setting is required for vapors that are
especially reactive or adsorb easily to instrument surfaces.
Such vapors include Cl2, PH3, NH3, HCN, and semi-
volatile organic compounds like diesel fuel and jet fuels.
For such compounds it is helpful to remove the water trap
filter for normal calibration and operation, which will
increase the pump speed to about 350 cc/min.  It is also
desirable to use inert connecting and sampling tubing, such
as Teflon instead of Tygon, and to make connections as
short as possible.

The pump is turned on automatically when the monitor is
turned on and remains on during normal operation.

If liquid or other objects are sucked into the water trap in
the inlet port and cause the pump to stall, the electronics of
the monitor will detect the obstruction and shut down the
pump immediately.  The alarm will be activated and a
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flashing error message “Pump” will be also displayed in
the LCD display.

The user needs to acknowledge the pump shut off
condition by pressing the [Y/+] key to re-start the pump.
Different pump shut-off thresholds are desired for the two
pump settings; this value can be adjusted in the Special
Diagnostic Mode as described in Section 8.1.
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2.9 Datalogging

The MultiRAE PLUS Multi-gas Monitor calculates and
stores the gas readings based on a user-specified
datalogging period and the type of measurement.  Two
types of gas measurements, average or peak concentration
can be stored for each sensor during each datalogging
interval.  The datalogging interval can be programmed
from one second to 60 minutes in one-second increments.
In addition, time stamp, user ID, site ID, serial number, last
calibration date, and alarm limits are also stored.  All data
is retained in a non-volatile memory so that it can be down
loaded at a later time to a PC.

Datalog Options
There are four ways to initiate the datalog operation:
- Automatic:  Start and stop datalogging automatically

when the monitor is turned on and off.
- Manual:  Start and stop datalogging by pressing a key

manually. There is a timer available to setup the
maximum datalogging time.

- Periodic:  Start and stop datalogging daily based on a
preset time (hour and minute).

- Scheduled:  Start and stop datalogging based on a preset
date and time (month, date, hour and minute).

Choose a datalog option
Most of the datalogging options can be programmed from
the monitor.  Additional options can be programmed using
a PC and downloaded to the monitor (see Chapter 5 for
details on how to program various datalogging options).
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Start/stop datalogging manually
If manual datalogging mode has been selected from the
normal operation menu, toggle through the menu using the
[MODE] key until the Start Datalog? prompt is
displayed.  Pressing the [Y/+] key turns on datalogging.
Likewise, pressing the [Y/+] key while Stop Datalog? is
displayed, turns off datalogging.

The other three datalogging options will start and stop
automatically without any user intervention:

Datalogging event
Each time a datalogging operation is initiated, a datalog
event is created.  Information, such as start time,
datalogging period, alarm limits, etc. will be recorded in
the event header, followed by the measurement data.  If
more than 900 measurement intervals are recorded in one
event, a new event will be created automatically.

Datalogging pause
Under the following conditions, the datalogging will be
paused automatically:
1) When entering programming mode, datalogging will
stop.  Upon exiting the programming mode, the
datalogging will resume.
2) When entering PC Communication standby mode,
datalogging will stop.  Upon exiting the PC communication
standby mode, datalogging will resume only if
datalogging mode was set to automatic mode.

In either case, a new datalog event will be created when the
datalogging is resumed.
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3. OPERATION OF ACCESSORIES

The accessories for MultiRAE PLUS include:

• Battery charger

• Alkaline battery adapter

• Water trap filter and remote sampling probe

• Dilution fitting

• Calibration adapter

WARNING:
To reduce the risk of ignition of hazardous
atmospheres, recharge battery only in area known
to be non hazardous.  Remove and replace
battery only in area known to be non hazardous.

Ne charger les batteries que dans emplacements
désignés non dangereuse.
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3.1 Battery Charging Operation

The charging circuit of the MultiRAE PLUS is built into
the monitor.  It only needs a regular AC to 12V DC adapter
(wall mount transformer) to charge the monitor.

1. Connect the AC adapter (or the optional automotive
charging adapter) to the DC jack on the MultiRAE
PLUS monitor.

2. The display will ask whether a discharge cycle (see
NOTE on next page) is required, press [N/-] key, and the
charging function will begin.  The display will show
“Charging” “Battery = x.x V.”  If a key is not pressed
within ten seconds, the charging will begin
automatically.
TOX1            VOC TOX2

   Charging
   Battery = 5.6V

LEL      OXY

3. The LED should be red in color when charging.  If the
battery is fully charged, the LED will change from red to
green.  The red color indicates that the battery is being
charged.  The green color indicates that the battery is
fully charged.  The display will also indicate “Fully
charged."  A completely discharged MultiRAE PLUS
monitor will be charged to full capacity within 10 hours.
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NOTE 1: The latest version of the MultiRAE PLUS
monitor has a smart charging circuitry and algorithm to
prevent overcharging; removing the charger is not
necessary.

NOTE 2: After one charging cycle the monitor recognizes
whether Li ion or NiCd batteries are installed.  When NiCd
batteries are present, the firmware displays: Deep
Discharge?  when the AC adapter is connected.  Perform
occasional deep discharge to the NiCd battery to maintain
full capacity by pressing the [Y/+] key when this message
appears.  The battery will begin deep discharge followed
by a charge cycle.  The deep discharge is useful to remove
memory effects of the NiCd battery, so that the charge
capacity is maintained.

The battery of the MultiRAE PLUS monitor will be
drained slowly even if the monitor is turned off.  If the
monitor has not been charged for 5-7 days, the battery
voltage will be low.

The factory supplied battery is designed to last for 10 hours
of normal operation (no alarm, no back light condition) for
a new battery under the best condition.  As the battery
becomes older or is subject to adverse conditions (such as
cold ambient temperature), the battery capacity may be
reduced significantly.  Li ion batteries do not have a
memory effect and tend provide longer run time even at the
same mAh rating.



OPERATION OF ACCESSORIES

3 - 4

3.2 Alkaline Battery Adapter

An alkaline battery adapter is supplied with each
MultiRAE PLUS kit.  It accepts four AA size alkaline
batteries and can be used in place of the Li ion or NiCd
battery pack to provide approximately 12-14 hours of
operation.  The adapter is intended to be used in emergency
situations when there is no time to charge the rechargeable
batteries.

Figure 3-1   Alkaline Battery Adapter

To install the adapter, remove the cover of the monitor.
Unplug the Li ion or NiCd battery pack from the battery
connector and plug the alkaline battery adapter into the
battery connector.

The internal charging circuit will automatically detect the
alkaline battery adapter and prevent charging of the battery.

Note:  The AA Alkaline battery adapter supplied
by RAE Systems Inc. is intrinsically safe!
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3.3 Water Trap Filter

The water trap filter is made of PTFE (Teflon) membrane
with a 0.2 micron pore size to prevent liquid water from
being sucked into the sensor manifold, which would cause
extensive damage to the monitor.  It will also prevent any
dust from entering the monitor and will prolong the
operating life of the sensors.

To install the water trap filter, simply slide the Tygon
tubing onto the ribbed inlet port on the monitor.  A male
Luer connector fits to the female Luer of the filter.  To
remove the filter, disconnect the Luer connector.

The water filter should not be used for normal calibration
and operation with vapors that are especially reactive or
adsorb easily to surfaces.  Such vapors include Cl2, PH3,
NH3, HCN, and semi-volatile organic compounds like
diesel fuel and jet fuels.  For these compounds the high
pump speed setting should be used (see Section 2.8).  It is
also desirable to use inert connecting and sampling tubing,
such as Teflon instead of Tygon, and to make connections
as short as possible.
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3.4 Remote Sampling Probe or Tygon Tubing
An optional 6-foot Teflon remote sampling probe with a
telescoping handle or a 15-foot Tygon tubing are handy
accessories for users to probe areas which are difficult to
reach, such as ceilings, storage tanks, underground man-
holes, etc.  Connect the male Luer connector at the end of
the remote sampling probe or the Tygon tubing to the
female Luer connector on the water trap filter.  The remote
sampling probe or the Tygon tubing is ready for operation.

Teflon remote sampling tubing should be used for reactive
gases such as Cl2, PH3, NH3, HCN, and for semi-volatile
organic compounds like gasoline and jet fuels.  A few feet
of Tygon tubing can completely absorb a kerosene-type
fuel.  Tygon can be used for the common confined space
entry gases including CO, H2S, and CH4.
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3.5 Dilution Fitting

An optional dilution fitting can be installed together with
the remote sampling probe or Tygon tubing on the gas inlet
port to dilute the gas samples.  This fitting is needed if the
gas sample does not contain more than 10% oxygen.  This
is due to the fact that the combustible sensor will not
function correctly when the oxygen concentration falls
below 10%.  The dilution fitting will increase the oxygen
concentration so that the combustible sensor can still be
used under oxygen deficient conditions.  The other use of
the dilution fitting is to measure the combustible, VOC or
toxic gas when the concentration exceeds the upper limit of
the sensor range.

See the dilution fitting instructions for proper installation.
Make sure to set the dilution ratio in the programming
mode (see Section 4.8) so that the correct gas reading will
be displayed when the dilution fitting is used.

WARNING:  For this application, the user must
have the monitor or dilution air inlet located in a
clean atmosphere outside the confined space and
use a remote access probe or Tygon tubing to
sample the gas under test.
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3.6 Calibration Adapter

There are two types of calibration adapter for the
MultiRAE PLUS monitor.  The PGM50-4P or PGM50-5P
model has a built-in sampling pump.  Therefore, the
calibration adapter for these two models is a simple 6 inch
Tygon tubing with a male Luer connector on one end.
During calibration, simply connect the tubing to the water
trap filter on MultiRAE PLUS and the calibration gas on
the other side.  Alternatively, the calibration gas can be
sampled 1) from a Tedlar gas bag, 2) from an open cup or
tube using flowing calibration gas exceeding the pump
demand, or 3) using a demand flow regulator directly from
the gas cylinder.

The PGM50-4 model does not have a built-in sampling
pump.  A special diffusion calibration adapter is provided.
During calibration, place this adapter over the front cover
of the monitor and connect the Tygon tubing to the
regulator on the gas bottle.
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4. PROGRAMMING OF MULTIRAE PLUS

The MultiRAE PLUS Monitor is built with a
microcomputer to provide programming flexibility for the
user.  Authorized users can re-calibrate the monitor, change
the alarm limits, change site ID, user ID, datalogging
period, real time clock, etc.

Programming is menu-driven to provide intuitive end-user
operation.  The display shows the menu options, and the
key pad is used for menu selection and data entry.

Note:  The real time monitoring of the gas
concentration continues while in the
programming mode.  However, during the
calibration or review datalog procedures, the real
time monitoring will pause until the procedures
are completed.  In addition, entering programming
mode will pause the datalogging operation
automatically.  After exiting programming mode,
datalogging operation will resume.
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4.1  Programming Mode

The MultiRAE PLUS has three user modes: text, display
and programming mode.  The user can access the
programming function only if they are in the programming
mode (or from text mode with password).  If the monitor
is set to display mode, the user cannot enter the
programming menu.  In this case, the user mode can be
changed only through a PC (see Section 5.0 for details on
setting up the user mode).

The programming mode allows users to change the setup
in the monitor, calibrate the monitor, modify the sensor
configuration and enter user information, etc.  The
programming functions are organized in a three tier menu
structure.  Table 4.1 shows the first tier of the
programming menu.  Each menu item includes several sub-
menus to perform additional programming functions.
Appendix A shows a more detailed menu tree structure.

Table 4.1
Programming Menu

Calibrate Monitor?

Change Alarm Limits?

View or Change Datalog?

Change Monitor Setup?

Change Sensor Configuration?
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Security Level
There are three levels of security in the MultiRAE PLUS
programming mode to provide further protection against
unauthorized changes to the monitor alarm settings and
other settings.  The level 2 security allows a user to enter
programming mode without any restriction.  This is the
default security setting.  The level 1 security requires a 4
digits password to enter programming mode.  Level 0
security allows a user to enter the programming mode
without any password checking, as in the level 2.
However, it does not allow a user to save any changes to
the alarm limits, real time clock, correction factor, user and
site information, etc.  A user can still perform calibration
with level 0 security.  The security level must be set using a
PC (see Chapter 5 for details on setting up the security
level).

Once inside the programming mode, LCD will display the
first menu.  Each subsequent menu item can be viewed by
pressing the [N/-] repeatedly until the desired menu is
displayed.  To enter the sub-menu of a particular menu,
press the [Y/+] key and the sub-menu will be displayed.

To exit the programming mode and return to the normal
operation, press the [MODE] key at any of the first tier
menu displays.
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4.2 Keys for Programming Mode

The three keys perform a different set of functions during
the programming mode as summarized below.

Table 4.2
 Key Function in Programming Menu

[MODE]: Exit menu when press momentarily or
exit data entry mode when pressed and
held for 1 second

[Y/+]: Increase numerical value for data entry
or confirm (yes) for a question

[N/-]: Decrease numerical value for data entry
or deny (no) for a question
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4.3 Entering into Programming Menu

1. Turn on the MultiRAE PLUS monitor (refer to Section
2.3 for the power on sequence).

2. Press and hold down both [MODE] and [N/-] keys for
three seconds to enter programming mode.  Note:  This
is to prevent a user from entering the programming
mode by accident.

3. If the security level is 0 or 2, after holding down two
keys for 3 seconds, the monitor should enter the
programming mode and the first menu item “Calibrate
Monitor?” will be displayed.

4. If the security level is 1, or user mode is text mode,
after holding down the two keys for three seconds, the
display will show “Enter Password = 0000” with the
left-most digit flashing.  The user should enter a
password starting from this flashing digit.

Note 1:  Prior to factory shipment, the MultiRAE PLUS
monitor was installed with “0000” as the default
password.

Note 2: For added security, “0000” is always displayed
instead of the actual password at this step.
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5. If the correct digit value is not  “0”, use the [Y/+] key or
[N/-] key to increase or decrease the digit value.  Then
press [MODE] key momentarily to confirm the digit
value.  Display shows the actual digit entered and
moves the flashing cursor to the next digit (to the right).

6. Repeat Step 5 until all four digits are entered.  Press
and hold [MODE] for one second.

7. If the entered password is correct, the monitor enters
the programming menu.  The first menu item “Calibrate
Monitor?” will be displayed.

8. If the password is incorrect, the display shows “Wrong
Password???” and returns to the regular display of
instantaneous gas readings.

9. If the User mode is set to display mode, a message
“Display Only!  Cannot enter....” will be shown.
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4.4 Calibration of MultiRAE PLUS Monitor

CALIBRATION WARNINGS:
The calibration of all newly purchased RAE
Systems instruments should be tested by

exposing the sensor(s) to known concentration
calibration gas before the instrument is used or

put into service.

For maximum safety, the accuracy of the
MultiRAE PLUS should be checked by exposing
the sensor(s) to known concentration calibration

gas before each day’s use.

In programming mode, the user may re-calibrate the
sensors in the MultiRAE PLUS monitor.  This is a two-
point calibration process using “fresh air“ and the standard
reference gas.  First, a “fresh air” which contains 20.9%
oxygen and no detectable VOC, toxic or combustible gases
is used to set the zero point for each sensor.  Then a
standard reference gas, which contains a known
concentration of a given gas, is used to set the second point
of reference (also known as span gas).  The two-point
calibration procedure is detailed below.  Table 4.3 shows
the sub-menus for calibration operations.
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Table 4.3
Calibration Sub-Menu

 Fresh Air Calibration?

 Multiple Sensor Calibration?

 Single Sensor Calibration?

 Modify Span Gas Value?

 Change LEL/VOC Span Gas?

The preferred calibration method for monitors with pumps
is to place the calibration gas in a gas sample bag (Tedlar
bag).  Connect the bag to the MultiRAE PLUS gas inlet
port when you are ready to perform the calibration.  Users
may find it more convenient to connect the MultiRAE
PLUS directly to the gas bottle using a flow-on-demand
type regulator.  Calibration through such a regulator will
produce similar results to the sample bag method with most
gases, but flow-on-demand regulators are not
recommended with H2S.  In an emergency, the MultiRAE
PLUS can also be calibrated directly from a fixed flow
regulator with a flow rate between 0.5 and 1.0 liters per
minute.

MultiRAE PLUS diffusion monitors must be calibrated
using a fixed flow regulator with a flow rate between 0.5
and 1.0 liters per minute.  Diffusion monitors are supplied
with a special calibration adapter that covers the gas
diffusion port.
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The calibration adapter links up the inlet port of the
MultiRAE PLUS Monitor to the gas sample bag (see
Figure 4-1).

Figure 4-1   Connection of Calibration Gas

MultiRAE PLUS diffusion monitors must be calibrated
using a fixed flow regulator with a flow rate between 0.5
and 1.0 liters per minute.  Diffusion monitors are supplied
with a special calibration adapter that covers the gas
diffusion port.
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4.4.1 Fresh Air Calibration
This procedure determines the zero point of the sensor
calibration curve.  To perform fresh air calibration, the
calibration adapter and a bottle of “fresh” air (optional) are
required.  The “fresh” air is clean dry air with 20.9 %
oxygen concentration and without any organic, toxic or
combustible gases or impurities.  If such an air bottle is not
available, any clean ambient air without detectable
contaminant can also be used.  A charcoal filter should be
used if one is not sure of the ambient air’s purity.

1. “Calibrate Monitor?” is the first menu item in Table
4.1.  Press [Y/+] to perform calibration.  The first sub-
menu shows:  “Fresh Air Calibration?”

2. If the “fresh” air bottle is available, twist on the
calibration adapter over the inlet port of the
MultiRAE PLUS Monitor and connect the other end
of the tube to the fresh gas bottle.  If the “fresh” air
bottle is not available, simply leave the monitor in an
area free of any detectable vapor.

3. Press the [Y/+] key to start “fresh air calibration” of the
monitor.  The display shows “zero ...in progress”
followed by the name of each sensor and the message
“zeroed”.  The display should show a reading of “20.9”
for the oxygen sensor and “0.0”, or a very small
number, for all other sensors.

4. After about a 5 second pause, the display will show the
message “Zero Cal Done!” and move to the next sub-
menu “Multiple Sensor Calibration?”
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4.4.2 Multiple Sensor Calibration
This function simultaneously determines the second point
of calibration curves for multiple sensors in the monitor.
Mixed standard reference gases is needed to perform this
procedure.  The user can choose several gas mixtures to be
used in multiple-sensor calibration.  Connect the tube to the
sampling bag filled with mixed gas as shown in Figure 4-1.

1. Continuing from Step 4 of the previous Section, the
display should show “ Multiple Sensor Calibration?”
Press the [Y/+] key.  The display shows all the pre-
selected gases for the sampling bag filled with mixed
gas and “OK?” question.  Press [Y/+] key to accept the
multiple sensor selection and start the calibration, or
press the [N/-] key to modify the sensor selection and
go to Step 7.

TOX1               VOC TOX2

CO     - - - - H2S
LEL      OK? OXY

LEL      OXY

2.   Turn on the valve of the sampling bag to start the flow
of the span gas.  Display shows “Apply Mixed Gas”
and will wait for the calibration gas to reach the sensor.
When the calibration gas has reached the sensor the
display will show “calibration in progress… 60” with
the countdown timer shows the number of remaining
seconds while the monitor performs calibration.  When
the countdown timer reaches 0, the display shows the
name of each sensor, the message “cal’ed!” and the
calibrated values for each gas.  If no gas has reached
the sensor after 60 seconds, the display will show “No
gas flow…” and abort the calibration.
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Note: the readings should be very close to the span gas
values.  After about 5 seconds pause, the display will
show the message “Span Cal Done!  Turn Off Gas”

3. This completes the multiple sensor calibration
procedure and moves to the next sub-menu item.

4. Turn off the flow of gas. Disconnect the calibration
adapter from the MultiRAE PLUS Monitor.

5. If the sensor failed the calibration, the sensor name and
an error message “failed, continue?” will appear.  Press
the [N/-] or [MODE] key to abort the calibration and
move directly to the next sub-menu item.  Press the
[Y/+] key to continue the next sensor calibration.  In
either case, the calibration data for the current sensor is
not changed.

6. From Step 1, if the [N/-] key is pressed, the display
shows all the sensor names which are selected for
multiple sensor calibration with the cursor blinking at
the first sensor location.
TOX1               VOC TOX2

CO*     - - - - H2S*
LEL*      OK? O2

LEL      OXY

Press the [Y/+] key to select the sensor and the [N/-]
key to de-select the sensor.  A previously selected
sensor will show an “*” next to the sensor name.  A
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previously de-selected sensor will not show an “*” next
to the sensor name.

7. Press the [MODE] key momentarily to move from one
sensor location to the next one.  Repeat Step 7 until all
of the sensors which need to be calibrated during
multiple sensor calibration are selected.  Press and hold
the [MODE] key for 1 second to save the new sensor
selection.

8. The display shows “Save?”  To confirm the new
selection, press the [Y/+] key to accept the change and
continue on with Step 2.  Press the [N/-] key or the
[MODE] key to discard the change and to continue on
with Step 2.

Cross Sensitivity: Some sensors may show cross
sensitivity to other gases.  Therefore, it is important to
choose the gas mixture carefully for the multiple sensor
calibration to avoid erroneous calibration due to cross
sensitivity.  For example, some VOC gases are known to
cause erroneous readings by the CO sensor.  In general, it
is recommended to calibrate the two toxic sensors,
combustible and oxygen sensor with a bottle of mixed gas
using the multiple sensor calibration procedure and to
calibrate the PID sensor with a bottle of a single VOC gas.
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4.4.3 Single Sensor Calibration

This procedure determines the second point of the sensor
calibration curve for a single sensor.  A standard reference
gas (span gas) is needed to perform this procedure.  Table
2.2 shows the standard calibration gas which is typically
used as the span gas in the factory (connect the tube to the
sampling bag filled with the standard gas as shown in
Figure 4-1).

1. Continuing from Step 4 or Step 6 of the previous
section, the display should show “Single Sensor
Calibration?”  Press [Y/+] key.  The display shows all
the installed sensors in the monitor with the cursor
blinking at the first sensor location.  Press [Y/+] key to
select the high-lighted sensor and start the calibration,
or press [MODE] key momentarily to move to the next
sensor location.

TOX1               VOC TOX2

CO      VOC H2S
LEL      pick? OXY

LEL      OXY

2.  Turn on the valve of the CO gas bottle to start the
flow of the span gas.  Display shows “Apply CO Gas”
and will wait for the calibration gas to reach the
sensor.  When the calibration gas has reached the
sensor the display will show “calibration in
progress…60” with the countdown timer shows the
number of remaining
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seconds while the monitor performs calibration.  When
the countdown timer reaches 0, the display shows the
sensor name and the calibrated value:

TOX1               VOC TOX2

CO cal’ed
reading =  50  ppm

LEL      OXY

If no gas has reached the sensor after 60 seconds, the
display will show "No gas flow…” and abort the
calibration.

Note:  The reading should be very close to the span gas
value.  After about 5 seconds pause, the display will
show the message “Span Cal Done!  Turn Off Gas”

3. This completes the single gas calibration procedure for
one sensor.  The display shows the single gas
calibration sub-menu for a user to select another sensor
or move to next calibration sub-menu.

4. Turn off the flow of gas.  Disconnect the calibration
adapter from the MultiRAE PLUS Monitor.

5. Repeat Step 1 to Step 5 to calibrate the next sensor.

6. Press the [MODE] key any time during Step 2 to reduce
waiting time.  If the sensor failed the calibration, the
sensor name and an error message “failed, continue?”
will appear.  Press [N/-] or [MODE] key to abort the
calibration and move directly to the next sub-menu
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item.  Press [Y/+] key to continue single gas
calibration.  In either case, the current calibration data
will not be changed.

Oxygen Sensor Calibration

The oxygen sensor calibration is slightly different from all
other sensors.  The oxygen sensor measures a range from 0
to 30% of oxygen in the air.  During “fresh” air calibration,
the oxygen sensor is calibrated to fixed 20.9% of oxygen.
During single sensor calibration, the user can supply a pure
nitrogen gas so that the oxygen sensor can be calibrated to
0% of oxygen.  The user can also supply other span
concentration of the oxygen, e.g. 19.5%, to calibrate the
oxygen sensor.  A question “0% oxygen?” will be asked.
Enter [Y/+] key if the pure nitrogen gas is used to calibrate
the oxygen sensor.  Otherwise, enter [N/-] key to calibrate
oxygen sensor to other span oxygen value.  During both
single or multiple sensor calibration, the oxygen sensor will
be calibrated to the span value defined in Section 4.4.4.

Note:  After a “0% oxygen” calibration, the user must
perform a fresh air calibration to ensure that the
oxygen sensor is calibrated correctly.

Calibration Time Stamp

When a single or multiple sensor calibration is performed,
a time stamp will be stored in the non-volatile memory.
This information will be included in the datalogging report.
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4.4.4 Modify Span Gas Value

This function allows the user to change the span values of
the standard calibration gases.

1. “Modify Span Gas Value?” is the next sub-menu item
in Table 4.3.

2. Press [Y/+] key.  Display shows:
TOX1               VOC TOX2

   50     100    25
   50     span 20.9

LEL      OXY

The cursor is blinking at the first digit of the first Span
value.  If the user wants to modify any one of the span
gas value, go to Step 3.  Otherwise, press and hold the
[MODE] key for 1 second to accept the previously
stored span gas value and move to the next calibration
sub-menu.

3. Starting from the left-most digit of the span gas value,
use [Y/+] or [N/-] key to change the digit value and
press [MODE] key momentarily to advance to next
digit, the cursor will move to the next digit to the right.
Repeat this process until all span gas values are entered.
Press and hold the [MODE] for 1 second to save the
new calibration gas value.

4. The display shows “Save?”  To confirm the new value
press the [Y/+] key to accept the change.  Press the [N/-]
key or the [MODE] key to discard the change and move
to the next calibration sub-menu.
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4.4.5 Change LEL/VOC Span Gas

This function allows the user to select a specific LEL or
VOC gas to be used as the span gas during LEL or VOC
gas calibration.

1. “Change LEL/VOC Span Gas?” is the next sub-menu
item in Table 4.3.

2. Press [Y/+] key.  If LEL sensor is installed and enabled,
the display shows:
TOX1               VOC TOX2

LEL Span = ?
methane

LEL      OXY

Otherwise, the message “No LEL installed” will
appear.

3. If the user does not want to change the LEL span gas,
press [Y/+] key to accept the current selection and exit
this sub-menu.

4. If the user wants to select a different LEL span gas,
press [N/-] key.  Then use [Y/+] or [N/-] key to scroll
through a list of gas names until a desired gas name
appears in the LCD display, then press [MODE] key to
select the new gas name.

5. The display shows “Save?”  To confirm the new gas
selection, press the [Y/+] key to accept the change.
Press the [N/-] key or the [MODE] key to discard the
change and move to the next display.
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6. If the VOC sensor is installed and enabled, the display
shows:
TOX1               VOC TOX2

VOC Span  = ?
isobutylene

LEL      OXY

Otherwise, the message “No VOC installed “ will
appear.

7. If the user does not want to change the VOC span gas,
press [Y/+] key to accept the current selection and exit
this sub-menu.

8. If the user wants to select a different VOC span gas,
press [N/-] key first then use [Y/+] or [N/-] key to scroll
through a list of gas names until a desired gas name
appears in the LCD display, then press [MODE] key to
select the new gas name.

9. The display shows “Save?”  To confirm the new gas,
press the [Y/+] key to accept the change.  Press the [N/-]
key or the [MODE] key to discard the change and return
to the first calibration sub-menu.
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4.5   Change Alarm Limits

In the programming mode, the users may change alarm
limits of each sensor for the MultiRAE PLUS Monitor.
Table 4.4 shows the sub-menus for changing the alarm
limits.

Table 4.4
Alarm Limit Sub-Menu

 Change High Alarm limit?

 Change Low Alarm limit?

 Change STEL alarm limit?

 Change Average alarm limit?

1. The sub-menu item in Table 4.4 allows the user to
change the high alarm limit, low alarm limit, STEL
alarm limit or average alarm limit.  The average alarm
limit can be “Running Average” or “TWA (Time
Weight Average) depending on the menu selection on
“Change Averaging Method” (see Section 4.7.8).  Press
[N/-] key to circle through the sub-menu.  Press [Y/+]
key to enter a sub-menu and the display shows “HIGH”,
“LOW”, “STEL”, “TWA” or “AVG” with a flashing
cursor on the left-most digit of the previously stored
alarm limits.
TOX1               VOC TOX2

   200      100.0    20
   20     HIGH  23.5

LEL      OXY
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      TOX1               VOC TOX2

   35       50.0     10
   10     LOW  19.5

LEL      OXY
             TOX1               VOC TOX2

   100       25.0     15
    STEL

LEL      OXY

            TOX1               VOC TOX2

   35       10.0     10
    TWA

LEL      OXY

            TOX1               VOC TOX2

1.0      10.0     10
    AVG

LEL      OXY

2. To modify this limit, starting from the left-most digit,
use the [Y/+] or [N/-] key to change the digit value and
press the [MODE] key momentarily to advance to the
next digit.  The flashing digit will move on to the next
digit to its right.  Repeat this process until all the new
Alarm limits are entered.  Press and hold the [MODE]
key for 1 second to exit data entry mode.  If there is any
change to the existing value, the display shows “Save?”
Press the [Y/+] key to accept the new value and move to
the next sub-menu.  Press the [N/-] key to discard the
changes. To preserve the previously stored alarm limit,
press and hold the [MODE] key for 1 second and the
monitor will exit data entry mode and move to the next
sub-menu.
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4.6 View or Change Datalog

MultiRAE monitor calculates and stores the gas readings at
a specified interval. The user can review these stored
readings or change datalog setup from the programming
mode.  Users can also program additional datalog options
in PC and down loaded them to the monitor (see Section
5.0 for details on how to program additional datalogging
options).  Table 4.5 shows the sub-menus for datalog
options:

Table 4.5
Datalog Sub-Menu

 Reset Peak and Minimum?
 Clear All Data?
 Change Datalog Period?
 Select Data Type?
 View Datalog?
 Enable / Disable Datalog?
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4.6.1 Reset Peak and Minimum

This function will reset peak and minimum data stored in
the non-volatile data memory.

1. “Reset Peak and Minimum?” is the first sub-menu item
in Table 4.5.

2. Press the [Y/+] key to clear the peak and minimum data
memory.  Display shows “Are You Sure?” to re-
confirm whether to reset peak and minimum data.

3. Press the [Y/+] key again will reset peak and minimum
data.

4. Press the [N/-] or [MODE] key to exit without resetting
the data and move to next datalog sub-menu.

Note:  STEL and TWA (or AVG) value will not be
affected when peak and minimum values are reset.
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4.6.2 Clear All Data

This function will erase all data stored in the non-volatile
data memory. This does not change STEL, TWA, Peak,
minimum concentration and run time values which are
stored in the other location.

1. “Clear All Data?” is the second sub-menu item in Table
4.5.

2. Press the [Y/+] key to clear the data memory.  Display
shows “Are You Sure?” to re-confirm the clearing of
memory.

3. Press the [Y/+] key again will erase all the data memory.

4. Press the [N/-] or [MODE] key to exit without clearing
the data memory and move to next datalog sub-menu.
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4.6.3 Change Datalog Period

The datalog period can be programmed from 1 to 3,600
seconds (1 hour).

1. “Change Datalog Period?” is the third sub-menu item in
Table 4.5.

2. Press the [Y/+] key, the display shows “New Period =
0060” with the left-most digit flashing, where “0060” is
the previously stored datalog period.

3. To modify this period, starting from the left-most digit,
use the [Y/+] or [N/-] key to change the digit value and
press the [MODE] key momentarily to advance to the
next digit.  The flashing digit will move to the next digit
to the right.  Repeat this process until all 4 digits of the
new period are entered. Press and hold the [MODE] key
for 1 second to exit data entry mode.  If there is any
change to the existing value, the display will show
“Save?”  Press the [Y/+] key to accept the new value
and exit the datalog sub-menu. Press the [N/-] key to
discard the changes and move to the next menu option.

4.  To preserve the previously stored period, press and hold
the [MODE] key for 1 second.  The monitor will exit
data entry mode and move to the next sub-menu item in
Table 4.5.
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4.6.4 Select Data Type

The user can choose to store either the average or the peak
value during each datalog period.

1. “Select Data Type?” is the fourth sub-menu item in
Table 4.5.

2.  Press the [Y/+] key, the display shows the current data
type:  “Data Type = Average?”

3.  Press the [Y/+] key to accept the currently displayed
data type.  Press [N/-] key to change to the other data.
type:  “Data Type = Peak?”  Press [MODE] key to exit
this sub-menu and move on to the next sub-menu.

4.  If there is any change to the existing selection, pressing
the [y/+] key, the display will show “Save?”  Then,
press the [Y/+] key to accept or the [N/-] key to discard
and move to the next sub-menu.

Note:  It is necessary to select “Average” data type in order
to calculate the correct STEL and TWA data for
datalogging report (see Section 5.9).
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4.6.5 View Datalog

This function allows the user to review all the data that is
stored in the non-volatile data memory.

1. “View Datalog?” is the fifth sub-menu item in Table
4.5.  Press the [Y/+] key and the LCD display shows the
first event number and start date and time of the event.
TOX1               VOC TOX2

 Event #  1  ?
   8/3/96 8:20

LEL      OXY

2. Press [Y/+] key to review data of the first event.  The
LCD display shows the stored data of each sensor and
the time stamp:
TOX1               VOC TOX2

   1       0.0      0
   2     8:20  20.5

LEL      OXY

3. Press the [Y/+] or [N/-] key to move forward or
backward to view other data of this event.  When
reaching the end or the beginning of the event, the
message “Start of data!” or “End of data!” will appear.
Press [MODE] key to exit the current event.

4. Press [N/-] key at Step 2 to see next event.  If there is
no more event, the message “no more event! quit?” will
appear.  Press [N/-] key to go back to the first event or
press [Y/+] key to exit and move to the next sub-menu.
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4.6.6 Enable / Disable Datalog

The user can choose to enable or disable the datalogging
function on each individual sensor.  This allows users to
selectively log certain sensor readings of interest.

1. “Enable / Disable Datalog?” is the sixth sub-menu item
in Table 4.5.

2. Press [Y/+] key.  The display shows all the installed
sensor in the monitor.  A previously selected sensor to
be datalogged is marked with an “*” next to the sensor
name.  The cursor is blinking at the first sensor
location.  Press [Y/+] key to enable the datalogging for
the sensor and [N/-] key to disable the datalogging.

 TOX1               VOC TOX2

CO*     VOC H2S*
LEL     pick OXY

LEL      OXY

3. Press [MODE] key momentarily to move from one
sensor location to the next one.  Repeat Step 2 until all
the sensors which needs to be datalogged are selected.
Press and hold [MODE] key for 1 second to save the
new sensor selection.

4. The display shows “Save?”  To confirm the new
selection, press the [Y/+] key to accept the change.
Press the [N/-] key or the [MODE] key to discard the
change and return to the first datalog sub-menu.
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4.7 Change Monitor Setup

In the programming mode, users may change monitor setup
or enter user information for the MultiRAE PLUS
monitor.  Table 4.6 shows the sub-menus for changing the
monitor.

Table 4.6
 Monitor Setup Sub-Menu
 Change Site ID?

 Change User ID?

 Change Alarm Mode?

 Change User Mode?

 Change Real Time Clock?

 Change Backlight Mode?

 Change Password?

 Change Pump Speed?

 Change Averaging Method?
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4.7.1 Change Site ID

The user can enter an 8 digit alphanumeric site ID in the
programming mode. This site ID will be included in the
datalog report.

1. “Change Site ID?” and “Change User ID?” are the first
and second sub-menu item in Table 4.6.

2. Press [MODE] key to choose one of them and press the
[Y/+] key, the display shows the current site ID:  “Site
ID = xxxxxxxx” or the current user ID:  “User ID =
xxxxxxxx” with the left most digit flashing.

3. Press the [Y/+] or [N/-] key to cycle through all 26
letters and 10 numerals.  Press [MODE] key
momentarily to advance to the next digit.  The flashing
digit will move to the next digit to the right.  Repeat
this process until all 8 digits of the new site ID are
entered.

4. Press and hold the [MODE] key for 1 second to exit the
data entry mode and move to the next monitor setup
sub-menu.

5. If there is any change to the existing site ID, the display
shows “Save?”  Press the [Y/+] key to accept the new
site ID and exit the monitor setup sub-menu.  Press the
[N/-] key to discard the changes and move to the next
sub-menu.
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4.7.2 Change Alarm Mode

There are two different alarm modes:  latched and
automatic reset in MultiRAE PLUS that can be
selected from the programming menu.

1. “Change Alarm Mode?” is the third sub-menu item in
Table 4.6.

2. Press the [Y/+] key, the display shows the current alarm
mode selection:  “Alarm Mode = Latched?”

3. Press the [Y/+] key to accept the currently displayed
alarm mode.  Press [N/-] key to change to the other
alarm mode:  “Alarm Mode = Auto Reset?”  Press
[MODE] key to exit this sub-menu and move to the
next monitor setup sub-menu.

4. If there is any change to the existing selection, pressing
the [y/+] key the display will show “Save?”  Then,
press the [Y/+] key to accept or the [N/-] key to discard
and move to the next sub-menu.
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4.7.3 Change User Mode

There are three different user modes: text, display and
programming in MultiRAE PLUS that can be selected
from the programming menu.

1. “Change User Mode?” is the fourth sub-menu item in
Table 4.6.

2. Press the [Y/+] key, the display shows the current user
mode selection:  “User Mode = Program?”

3. Press the [Y/+] key to accept the currently displayed
user mode.  Press [N/-] key to scroll through the other
two user modes.  Press [MODE] key to exit this sub-
menu and move to the next monitor setup sub-menu.

4. If there is any change to the existing selection, pressing
the [y/+] key the display will show “Disable Program!
Are you Sure?”  Then, press the [Y/+] key to accept or
the [N/-] key to discard and move to the next sub-menu.

NOTE:  If the user mode is changed to display or text
mode, the user can no longer enter the programming menu.
Therefore, the user cannot change the user mode back to
program mode from the monitor.  The only way to
change the user mode back to “program” mode is to use
a PC and the ProRAE-Suite program or “multicfg”
program (see Section 5 for details).
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4.7.4 Change Real Time Clock

The MultiRAE monitor is equipped with a real time clock.
The user can enter the correct date and time into the real
time clock in the programming mode.

1. The fifth sub-menu item in Table 4.6 is “Change Real
Time Clock?”

2. Press [Y/+] key, the display shows both the current date
and time:  “Date =  mm / dd” and “Time = hh : mm”
with the left most digit of the date flashing.

3. To modify this value, use the [Y/+] or [N/-] key to change
the digit value and press the [MODE] key momentarily
to advance to the next digit.  The flashing digit will
move on to next digit to its right.  Repeat this process
until the new date and time values are entered. Press
and hold the [MODE] key for 1 second to exit data entry
mode.  If there is any change to the existing value, the
display shows “Save?”  Press the [Y/+] key to accept the
new value and move to next sub-menu.  Press the [N/-]
key to discard the changes and move to next sub-menu.
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4.7.5 Change Back Light Mode

The MultiRAE monitor allows a user to choose to turn on
and off LCD back light automatically when ambient light
falls bellow or above a threshold level or to turn on and off
the back light manually by pressing the [N/-] key.

1. The sixth sub-menu item in Table 4.6 is “Change
Backlight Mode?”

2. Press [Y/+] key, the display shows the current back
light mode:  “Back Light Mode = manual turn on?”

3.  Press the [Y/+] key to accept the currently displayed
back light mode.  Press [N/-] key to change to the other
back light mode:  “Back Light Mode = manual turn
on?”  Press [MODE] key to exit this sub-menu and
move to the first monitor setup sub-menu.

4. If there is any change to the existing selection, pressing
the [Y/+] key the display will show “Save?”  Then,
press the [Y/+] key to accept or the [N/-] key to discard
and move to the next sub-menu.
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4.7.6 Change Password

The user can modify the password from the monitor.

1. The seventh sub-menu item in Table 4.6 is “Change
Password?”

2. Press the [Y/+] key and the display shows the current
password:  “Enter new password = xxxx” with the left
most digit flashing.

3. Press the [Y/+] or [N/-] key to cycle through all 10
numerals.  Press [MODE] key momentarily to advance
to the next digit.  The flashing digit will move to the
next digit to the right.  Repeat this process until all 4
digits of the new password are entered.

4. Press and hold the [MODE] key for 1 second to exit the
data entry mode and move to the next monitor setup
sub-menu.

5. If there is any change to the existing password, the
display shows “Save?”  Press the [Y/+] key to accept the
new password.  Press the [N/-] key to discard the
changes and move to the next sub-menu.

6. The monitor next asks for this value to be confirmed.
“Confirm New Password = 0000” with the left most
digit flashing.  The number must be reentered as before
to exit the monitor setup sub-menu.  If misentered the
second time, the password reverts to its original setting.



PROGRAMMING OF MULTIRAE

4 - 36

4.7.7 Change Pump Speed

There are two speed settings for the pump motor in the
MultiRAE PLUS that can be selected from the
programming menu:  low (default) and high.  The “high”
setting should be used for long lengths of tubing or when
rapid changes in input conditions are expected.  “Low”
may be selected when the operating conditions are slow to
change.  Low may also be used to prolong pump motor life,
LEL sensor life and battery run time.  Note that this screen
may not be present for diffusion models or if speed control
is not available.

1. “Change Pump Motor Speed?” is the eighth sub-menu
item in Table 4.6.

2. Press the [Y/+] key, the display shows the current pump
speed selection:  “Pump Speed = Low?”

3. Press the [Y/+] key to accept the currently displayed
pump speed and move to the next monitor setup sub-
menu.  Press [N/-] key to change to the other speed
“Pump Speed = High?”  Press [MODE] key to exit this
sub-menu and move to the next monitor setup sub-
menu.
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4.7.8 Change Averaging Method

There are two methods of calculation used in the averaging
of the monitor. Using this selection can cause the
calculation to be performed using an eight hour time
weighted average (TWA), the default, or a running average
(AVG).  The display indicator for whichever averaging
type is selected will show on the LCD display wherever the
average is indicated.

1. “Change Averaging Method?” is the ninth sub-menu
item in Table 4.6.

2. Press the [Y/+] key, the display shows the current
average selection: “Average Type = TWA?”

3. Press the [Y/+] key to accept the currently displayed
type.  Press [N/-] key to change to the other selection:
“Average Type = Running Average?”, and [Y/+] to
select.

4. If there is any change to the existing selection, pressing
the [Y/+] key, the display will show “Save?”  Then,
press the [Y/+] key to accept or the [N/-] key to discard
and move to the first  setup sub-menu.
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4.8 Change Sensor Configuration

In the programming mode, users may change several
sensor related configurations of the MultiRAE PLUS
monitor.  Table 4.7 shows the sub-menus for setting
various configurations of the sensors.

Table 4.7
Sensor Configuration Sub-Menu
 Change LEL/VOC Gas Selection?

 Enable / Disable Sensors?

 Change Dilution Ratio?

 Change PID Lamp Type?

Before these sub-menus are described, the term
“Correction Factor” needs to be explained:

Correction Factor
The PID and LEL sensor used in MultiRAE PLUS are
broad band sensors (i.e., they respond to a broad range of
gases). Typically, these sensors show a different sensitivity
to different gases.  The correction factor for a specific gas
is defined as:

  Sensitivity to a calibration gas
Correction Factor   =   ________________________

  Sensitivity to a specific gas
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Correction factors are often used to obtain a calculated
concentration of a specific gas while using a different gas
during calibration.

The MultiRAE PLUS monitor store three sets of correction
factors: one for the LEL sensor, one for the 10.6 eV PID
sensor and the other for the 11.7 eV PID sensor. Each set
consists of 20 to 40 different gases.  The user can choose
one gas from the list to be the calibration gas and another
gas to be the measurement gas.

For example, the user can choose methane as the
calibration gas for the LEL sensor and select pentane as the
measurement gas.  The MultiRAE PLUS monitor will
calculate the correction factor between these two gases and
convert the measured value of the LEL sensor into
equivalent concentration of the pentane gas.

Similarly, the user can choose one VOC gas for calibration
and choose another VOC gas for measurement.  In
addition, the correction factor is different for the PID
sensor due to different energy of the UV lamp used in the
PID sensor.  The user needs to choose the correct type of
UV lamp (10.6 eV or 11.7 eV) for the PID sensor in
Section 4.8.4.
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4.8.1 Change LEL/VOC Gas Selection

This function allows users to choose one of the pre-stored
LEL or VOC gases in the monitor and calculate its
correction factor relative to the LEL or VOC calibration
gas.  This factor will then be used during gas
measurements to show the equivalent concentration of the
selected LEL or VOC gas.  The user can also modify this
relative correction factor to increase or decrease the gas
reading.  This allows users to create a custom factor for a
specific gas or mixture of gases.

1. “Change LEL/VOC Gas Selection?” is the first sub-
menu item in Table 4.7.

2. Press [Y/+] key.  If an LEL sensor is installed and
enabled, the display shows:
TOX1               VOC TOX2

LEL Gas = ?
methane

LEL      OXY

Otherwise, the message “No LEL installed” will be
displayed and skip to Step 8.

3. If the user does not want to change the LEL
measurement gas, press [Y/+] key to accept the current
gas and skip to Step 6.

4. If the user wants to modify the LEL measurement gas,
press [N/-] key first, then use [Y/+] or [N/-] key to
scroll through a list of gas names until the desired gas
name appears in the LCD display, then press [MODE]
key to select the new gas name.
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5. The display shows “Save new gas?”.  To confirm the
new gas, press the [Y/+] key to accept the change.  Press
the [N/-] key or the [MODE] key to discard the change
and move to the next step.

6. Display shows
TOX1               VOC TOX2

methane
LELFactor=1.00 ?

LEL      OXY

     where “1.00” is the calculated correction factor of the
selected gas in Step 4.

7. If the user does not want to modify the LEL correction
factor, press [Y/+] key and go to Step 8.  To modify this
factor, press [N/-] key first.  Then starting from the left-
most digit, use the [Y/+] or [N/-] key to change the digit
value and press the [MODE] key momentarily to
advance to the next digit.  The flashing digit will move
on to next digit to its right.  Repeat this process until all
4 digits of the new factor are entered.  Press and hold
the [MODE] key for 1 second to exit data entry mode.
If there is any change to the existing value, the display
shows “Save?”  Press the [Y/+] key to accept the new
value and exit the gas selection sub-menu.  Press the
[N/-] key to discard the changes.
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8. If the VOC sensor is installed and enabled, the display
will show:
TOX1               VOC TOX2

VOC Gas = ?
isobutylene

LEL      OXY

Otherwise, the message “No VOC installed” will be
displayed and move to the next sub-menu.

9. If the user does not want to change the VOC
measurement gas, press [Y/+] key to accept the current
gas and go to Step 12.

10. If the user wants to modify the VOC measurement gas,
press [N/-] key first, then use [Y/+] or [N/-] key to
scroll through a list of gas names until the desired gas
name appears in the LCD display, then press [MODE]
key to select the new gas name.

11. The display shows “Save?”  To confirm the new gas,
press the [Y/+] key to accept the change.  Press the [N/-]
key or the [MODE] key to discard the change and move
to the next step.

12. Display shows
TOX1               VOC TOX2

isobutylene
VOCFactor=1.00 ?

LEL      OXY
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      where “1.00” is the calculated correction factor of the
selected gas in Step 10.

13. If the user does not want to modify the VOC correction
factor, press [Y/+] key and exit the sub-menu.  To
modify this factor, press [N/-] key first.  Then starting
from the left-most digit, use the [Y/+] or [N/-] key to
change the digit value and press the [MODE] key
momentarily to advance to the next digit.  The flashing
digit will move on to next digit to its right.  Repeat this
process until all 4 digits of the new factor are entered.
Press and hold the [MODE] key for 1 second to exit
data entry mode.  If there is any change to the existing
value, the display shows “Save?”  Press the [Y/+] key to
accept the new value and exit the gas selection sub-
menu.  Press the [N/-] key to discard the changes.
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4.8.2 Enable / Disable Sensor

This function allows the user to selectively enable or
disable individual sensors in the MultiRAE PLUS
monitor.  When a sensor is disabled, the sensor will not
measure nor display the gas concentration.

1. “Enable / Disable Sensors?” is the second sub-menu
item in Table 4.7.

2. Press [Y/+] key.  The display shows all the installed
sensors in the monitor.  A previously enabled sensor is
marked by an “*’ next to the sensor name.  The cursor
will blink at the first sensor location.  Press [Y/+] key to
enable the sensor and [N/-] key to disable the sensor.  A
previously disabled sensor will show “----” instead of
the sensor name.

 TOX1               VOC TOX2

CO*     VOC H2S*
LEL*     pick       OXY*

LEL      OXY

3. Press [MODE] key momentarily to move from one
sensor location to the next one.  Repeat Step 2 until all
the sensors which needs to be enabled are selected.
Press and hold [MODE] key for 1 second to save the
new sensor selection.

4. The display shows “Save?”  To confirm the new
selection, press the [Y/+] key to accept the change.
Press the [N/-] key or the [MODE] key to discard the
change and move to the next sub-menu.
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4.8.3 Change Dilution Ratio

The user can insert an optional dilution fitting on the
MultiRAE PLUS gas inlet port to dilute the gas sample.
The user can enter a dilution ratio (from 1 to 10) from the
programming menu so that the reading can be compensated
to show the actual concentration of the gas sample with the
dilution fitting.

1. “Change Dilution Ratio?” is the third sub-menu item in
Table 4.7.

2. Press the [Y/+] key, the display shows the current
dilution ratio:  “Dilution Ratio = xx” with the left most
digit flashing.

3. Press the [Y/+] or [N/-] key to increase or decrease the
value of the digit.  Press [MODE] key momentarily to
advance to the next digit.  The flashing digit will move
to the next digit to the right.  Repeat this process until
both digits of the new dilution ratio are entered.

4. Press and hold the [MODE] key for 1 second to exit the
data entry mode and move to the next sub-menu.

5. If there is any change to the existing dilution ratio, the
display shows “Save?”  Press the [Y/+] key to accept the
new ratio and exit the sub-menu.  Press the [N/-] key to
discard the changes and move to the next sub-menu.
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4.8.4 Change PID Lamp Type

This programming menu only applies to the monitor which
is equipped with a PID detector option.  There are two
different energy UV lamps available for the PID sensor:
10.6 eV and 11.7 eV.  The user can select either lamp
from the programming menu.

1. “Change PID Lamp Type?” is the fourth sub-menu item
in Table 4.7.

2. Press the [Y/+] key, the display shows the current PID
lamp selection:  “PID Lamp = 10.6 eV?”

3. Press the [Y/+] key to accept the currently displayed
PID lamp.  Press [N/-] key to change to the other lamp.
Press [MODE] key to exit this sub-menu and return to
the first sub-menu.

4. If there is any change to the existing selection, pressing
the [Y/+] key the display will show “Save?”  Then,
press the [Y/+] key to accept the [N/-] key to discard and
return to the first sub-menu.
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4.9 Exit Programming Mode

1. To exit programming mode from the first tier menu
level (see Table 4.1), press the [MODE] key once.
Display shows an instantaneous reading of normal
operation mode.

2. To exit programming mode from 2nd tier sub-menu
level (see Table 4.2 - 4.6), press the [MODE] key twice.

3. To return to programming mode, press and hold down
both the [MODE] and [N/-] keys for 3 seconds as
described in Section 4.4.
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5. COMPUTER INTERFACE FOR
MULTIRAE PLUS

Each MultiRAE PLUS with a datalogging option is
shipped with a software package, called ProRAE-Suite,
and a serial computer interface cable.

This software package runs on any IBM compatible
Personal Computer (PC) under Windows 95, Windows
98, Windows NT 4.0 and later environments.  It allows
the user to configure the MultiRAE PLUS through a user
friendly interface and send the configuration information
from the PC to the MultiRAE PLUS monitor.  Collected
data can also be extracted from the MultiRAE PLUS to the
PC in order to perform data analysis, report generation or
record keeping.  Installation and operation of this software
package is described in the following sections.
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5.1 Install ProRAE-Suite Software

ProRAE-Suite software package is supplied with the
MultiRAE PLUS datalogging monitor.  This software
package is available on two 3.5” setup diskettes.  To install
the ProRAE-Suite software, insert the first setup diskette
into the “A” or “B” floppy disk drive.  Click the Start
button on the taskbar to display the start menu, then click
the Run from the start menu to display the Run dialog box.
If the setup diskette is in disk drive A, type A:\Setup.exe in
the Open field, as shown in Figure 5-1.

Figure 5-1   Run Dialog Box

Press the Enter key on the keyboard or click the OK button
on the menu to start the setup process.  If the user choose
the default settings in every steps of the process, the
ProRAE-Suite software package will be installed under the
default directory:  C:\Program Files\RAE Systems
Inc\ProRAE-Suite.  After the software is installed
successfully, a new menu item ProRAE-Suite is added to
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the Programs menu.  To start the ProRAE-Suite software,
click the Start button on the taskbar to display the Start
menu, click the Programs menu item to display the
Programs submenu, then click the ProRAE-Suite menu
item to display the ProRAE-Suite submenu.  There are
two submenu items under the ProRAE-Suite submenu:
ProRAE-Suite and Readme, as shown in Figure 5-2.
Click the ProRAE-Suite submenu item to start the
ProRAE-Suite software.

Figure 5-2   Start Menu
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5.2 Connect MultiRAE PLUS to PC

The basic kit of a MultiRAE PLUS datalogging monitor
includes a serial interface cable.  Connect the DB-9
connector side of the cable to the serial port of the PC, and
connect another side of the cable to the MultiRAE PLUS
monitor.

Turn on the power to the MultiRAE PLUS monitor.  Press
the [MODE] key several times until the LCD shows
“Communicate with PC?”  Press the [Y/+] key and the
display shows “Monitor will Pause, OK?”  Press [Y/+] key
to confirm and the display shows “Ready...” to indicate that
the MultiRAE PLUS monitor is ready for communication
with PC.  During the communication session, the PC will
directly control the MultiRAE PLUS monitor through the
serial link.  There is no need for users to press any key on
the MultiRAE PLUS monitor during the communication
session.

If no data transfer has occurred within one minute, the
MultiRAE PLUS monitor will return to instantaneous
reading display.

Note:  Do not connect to the parallel port of the PC by
mistake.  The parallel port is usually a 25 pin female D
connector on the back of the PC, the serial port is usually a
25 or 9 pin male D connector.  If the serial port on the PC
is a 25 pin connector, the user needs to use a 25 pin to 9 pin
adapter in order to accept the serial cable.
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5.3 Start ProRAE-Suite Software

To start the ProRAE-Suite software, click the Start button
on the taskbar to display the Start menu, click Programs -
> ProRAE-Suite -> ProRAE-Suite sub-menu item to start
the ProRAE-Suite software.  Figure 5-3 shows the main
window of the ProRAE-Suite software.

Figure 5-3   ProRAE-Suite Main Window

The functions of ProRAE-Suite software can be divided
into three categories:
1) Configuration data category.  This category includes

editing the configuration data file, sending the
configuration data to the MultiRAE Plus monitor and
receiving the configuration data from the MultiRAE
Plus monitor, etc.

2) Logged data category.  This category includes receiving
the logged data from the MultiRAE Plus monitor,
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displaying the logged data in different format, exporting
the logged data to a tab delimited text file so that it can
be read by the Microsoft Excel software, etc.

3) Upgrade category.  This category includes upgrading
the datalog feature of the MultiRAE Plus monitor, and
upgrading the firmware in the MultiRAE Plus monitor.

There is a tool bar beneath the menu bar.  The frequently
used functions are represented in this tool bar in the form
of a small icon.  For example, the Receive data function in
the Communication sub-menu is represented as a small
arrow with the letters “RECV.”  When the mouse cursor (a
small arrow) is positioned near each icon in the tool bar, a
short text will also appear at the bottom of the Window to
describe the function of this icon.

This tool bar allows users to invoke a function
conveniently by clicking on the icon without going through
the sub-menus.
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5.4 Setup Communication Port

It is necessary to setup the communication port on the
ProRAE-Suite software so that the MultiRAE PLUS
monitor can communicate with the PC correctly.  Figure 5-
4 shows the Setup Port dialog box.  Choose the
appropriate port according to the PC’s serial port setup.

Figure 5-4   Setup Port Dialog

Note:  In most PC's, there are two serial ports.  Make sure
that the serial port selected in the Setup Port dialog box
matches the actual serial port connected to the MultiRAE
Plus monitor.  The default serial port for ProRAE-Suite is
COM1.  If the incorrect serial port is selected, an error
message of “error occur during serial port initialization”
will appear when a user tries to communicate between the
PC and the MultiRAE Plus monitor.
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5.5 Processing the Configuration Data
The ProRAE-Suite software allows the user to edit the
configuration data, send the configuration data to the
MultiRAE Plus, and receive the configuration data from
the MultiRAE Plus monitor. The following subsection
describes the detail of each operation.
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5.5.1 Editing the Configuration Data

There are two different sources of the configuration files.
One is loaded from the unit, the other is from a
configuration file.

To load and review the configuration of the monitor. From
the main menu of the ProRAE-Suite software, select the
Receive Configuration… menu item from the
Communication dropdown menu, then click the OK if the
unit is connected to the communication port and ready.

To load a saved configuration file. From the main menu,
select Open from the File… dropdown menu, a dialog box
appears.  Select the “Files of type:” to Config Files [*.cfg],
as shown in Figure 5-5.

Figure 5-5   Open Dialog Box
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There should be one or more configuration files in the file
list.  Each configuration file has a file extension of “.CFG”.
There is one generic MultiRAE Plus configuration supplied
with ProRAE-Suite software:
Default_MultiRAE_V###.CFG, where ### is the version
number of the default configuration file. For example,
Default_MultiRAE_V216.cfg means this file is for
MultiRAE monitor and its version is V2.16. Choose a
configuration file by highlighting the file name and press
the Enter key or click the OK button on the dialog box.

Once the configuration file is open, the configuration data
is displayed in the newly opened client window, as shown
in Figure 5-6.

Figure 5-6   Displayed Configuration Data
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To edit the opened configuration data file, click the Edit ->
Configuration menu item or the Configuration toolbar
button to open the Edit Configuration File dialog box, as
shown in Figure 5-7.

Figure 5-7   Edit Configuration File Dialog Box

The Edit Configuration File dialog box contains three tab
pages:  General, Gas Parameters and Gas Selection.  To
change a specific configuration setting, click the
corresponding tab page header to bring that tab page to the
front, then change the configuration setting on that tab
page.  When finished editing the configuration settings,
click the OK button to close the Edit Configuration File
dialog box.  The new values of the configuration settings
will be reflected in the client window.
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Note:  The VOC gas configuration settings applies only to
monitors which are equipped with PID detector option.

The General tab page, which is shown in Figure 5-7,
allows a user to change the general settings of the
configuration data.  The following is the description of
each field in the General tab page of the Edit
Configuration File dialog:

ID:
This section sets the identification that is used throughout
the datalog process.  Both editing fields, Site and User, can
hold up to eight alphanumeric letters.

Security Level:
There are three levels of security. They are used to provide
protection against unauthorized changes to monitor settings
which can be changed by using the programming menu of
the MultiRAE PLUS monitor when the instrument is in the
programming mode.

Level 0 allows a user to enter the programming menu
without password checking, but does not allow changes to
alarm limits, real time clock, correction factor, or user and
site information, etc. The user can still perform
calibrations.

If Level 1 is selected, a four digit password is required to
enter the programming menu.

If Level 2 is selected, the programming menu may be
entered without restriction.  Any changes made in the
programming menu can be saved.
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Password:
The four digit password must be entered if level 1 is
selected as the security level or the monitor is in the Text
mode.  Entry to the programming menu requires that this
password be entered.

User mode:
In the Text mode, the monitor only displays the sensor
name and an OK message during normal operation.  In the
Display mode, the user can view several readings in the
normal operation, but cannot enter the programming menu.
In the Program mode, the user can enter the programming
mode to calibrate the monitor or change various setup in
the monitor.

Warm-up Time:
This option allows the user to choose the warm-up time of
the instrument, in seconds.

Comfort Beep:
This option allows the user to specify a time interval that
the buzzer will beep once to remind the user that the
monitor is on.  If zero is entered for the time interval, then
the security beep feature is disabled.
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Back Light:
This option allows the user to choose to turn on and off the
LCD back light manually or automatically based on the
ambient light sensor input.  If Manual mode is selected,
the user can also enter a time out period so that the back
light will be turned off automatically after the time out
period.  If Auto is selected, the ambient light sensor will
automatically turn on and off the backlight.

Clock from PC:
This option allows the PC clock to be downloaded to the
MultiRAE PLUS monitor so that the user does not need to
manually set the clock in the MultiRAE PLUS monitor.

Pump Speed:
This option allows the user to choose the high pump speed
or low pump speed for the MultiRAE PLUS monitor.

Measure:
The user can choose to record the average or peak (Max)
reading of all the sensors during each datalog period.

Datalog Interval:
The datalog interval is the rate at which datalog samples
are recorded while the datalog is running.  The unit of
datalog interval is second. The datalog interval determines
how often a new sample is calculated and stored to the
datalog. The unit of a datalog interval is one second.



COMPUTER INTERFACE FOR MULTIRAE PLUS

5 - 15

Datalog Selection:
The user can choose one or more sensors for datalogging
purpose.  This does not activate or inactivate the particular
sensor’s readings except for the purpose of datalogging
recording.

Datalog Mode:
This may be set to either of four choices:
-- With Automatic start/stop, the datalogging begins
when the monitor is turned on and ends when it is turned
off.
-- With Manual start/stop, the datalog can begin by a
series of key presses in the menu of normal operation.  The
maximum run time determines an automatic end to the
datalog or it can be stopped manually.
-- If Periodic start /stop (or daily) mode is chosen, the
user must specify the start and stop hour and minute.  The
interval between start and stop is the period of time the
monitor will datalog (at “data logging period” rate).
-- With Scheduled start/stop, all the entry boxes for year,
month, day, hour and minute for both start and stop time
must be entered to specify when the datalog is to occur.

Run Time:
If manual start/stop mode for datalogging is chosen, the
user needs to specify a maximum run time.  After the
monitor has been on for the specified run time, datalogging
will be turned off automatically.
Start Time and Stop Time:
If scheduled start/stop mode is chosen for datalogging, all
entry boxes must be completed for start and stop year,
month, day, hour and minute.  The monitor must already be
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turned on.  Then once the start date/time is reached, the
monitor will start datalogging.  When the stop date/time is
reached, the datalogging will stop automatically.  With
periodic start/stop mode, the hours and minutes are used
for the data log period to be run each day.

Figure 5-8 shows the Gas Parameters tab page which
allows the user to change the gas parameters of the
configuration data. The following is the description of each
field in the Gas Parameters tab page of the Edit
Configuration File dialog:

Figure 5-8   Gas Parameters Settings Tab Page
LEL Alarm Levels (%):
This is the place where the user can specify the low alarm
level (%) and high alarm level (%) for LEL sensor.
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OXY Alarm Levels (%):
This is the place where the user can specify the low alarm
level (%) and high alarm level (%) for OXY sensor.

VOC Alarm Levels (ppm):
This is the place where the user can specify the STEL
alarm level (ppm), TWA alarm level (ppm), low alarm
level (ppm) and high alarm level (ppm) for VOC sensor.

Tox1 Alarm Levels (ppm):
This is the place where the user can specify the STEL
alarm level (ppm), TWA alarm level (ppm), low alarm
level (ppm) and high alarm level (ppm) for Tox1 sensor.

Tox2 Alarm Levels (ppm):
This is the place where the user can specify the STEL
alarm level (ppm), TWA alarm level (ppm), low alarm
level (ppm) and high alarm level (ppm) for Tox2 sensor.

Alarm mode:
If Auto reset is chosen, the alarm will stop as soon as the
alarm condition goes away.  The alarm will remain on if
the Latched option is chosen.  To turn off a latched alarm,
press [Y/+] key to acknowledge the alarm condition.

Power On Zero:
This option allows the monitor to perform a fresh air
calibration automatically when the monitor is turned on.
Care must be taken, when using this mode, to ensure that
the monitor is in a fresh air environment when turned on.
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Calibration span:
The user can specify the calibration gas span for LEL,
OXY, VOC, Tox1 and Tox2 sensor here.

Figure 5-9   Gas Selection Settings Tab Page

Figure 5-9 shows the Gas Selection tab page.  There are
three sets of gases for correction factors that the user can
choose: one for the LEL sensor, one for the PID sensor
with 10.6 eV lamp and other one for the PID sensor with
the 11.7 eV lamp. The following is the description of each
field in the Gas Selection tab page of the Edit
Configuration File dialog box:

VOC10.6 Current Gas selection:
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This is the place where the user can choose a set of gases
for the correction factors of the PID sensor with 10.6 eV.
The user can choose one gas from the Calibration Gas list
box for calibration and another gas from the Measurement
Gas list box for measurement.  Each list box contains a list
of 20 to 40 gases.  Scroll the list using the up or down
arrow until the desired gas name is shown.  Press Enter key
to select the gas.  The user can also enter a custom gas
name (up to 16 characters long) and a custom correction
factor.

VOC11.7 Current Gas selection:
This is the place where the user can choose a set of gases
for correction factors of the PID sensor with 11.7 eV.  The
user can choose one gas from the Calibration Gas list box
for calibration and another gas from the Measurement
Gas list box for measurement.  Each list box contains a list
of 20 to 40 gases.  Scroll the list using the up or down
arrow until the desired gas name is shown.  Press Enter key
to select the gas.  The user can also enter a custom gas
name (up to 16 characters long) and a custom correction
factor.

LEL Current Gas selection:
This is the place where the user can choose a set of gases
for correction factors of the LEL sensor.  The user can
choose one gas from the Calibration Gas list box for
calibration and another gas from the Measurement Gas
list box for measurement.  Each list box contains a list of
20 to 40 gases.  Scroll the list using the up or down arrow
until the desired gas name is shown.  Press Enter key to



COMPUTER INTERFACE FOR MULTIRAE PLUS

5 - 20

select the gas.  The user can also enter a custom gas name
(up to 16 characters long) and a custom correction factor.

In the Others tap, the user can put in a power-on-
customized name. The name will be displayed when the
unit is powered on.  The user can also choose the
supporting of the printer option.

OK/Cancel:
When the configuration changes are completed, click on
the OK button to save the configuration and return to the
client window.  Click on Cancel button to abort the
configuration changes.
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5.5.2 Send Configuration to MultiRAE Plus

After the configuration data is loaded into the ProRAE-
Suite software, the user can send the configuration settings
to the MultiRAE PLUS monitor.  To send the configuration
settings to the instrument, click Communication->Send
Config menu item or click the send toolbar icon (right
arrow with “Send” letters), a message box will appear to
remind the user to connect the instrument to the PC
through the serial port. After making sure that the
instrument is connected to the PC, click the OK button to
start the data transfer.

After the configuration information is sent successfully, a
message box will appear to indicate that the sending
configuration process is completed.  Click the OK button to
close the message box.

If the communication is not successful, an error message
indicating that there is no response from the instrument
will appear.  Check the cable to make sure that the
connectors on both ends of the cable are securely seated in
the sockets.  Try to send the information again.   If the
error message still appears after repeated attempts, call an
authorized service center for help.
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5.5.3 Saving Configuration Data

In order to save the configuration information for future
use, user can click File->Save or File->Save As menu item
to save the opened configuration data to a file. Once the
configuration file is saved on disk, it can be opened at a
later time for further modification or can be sent to the
MultiRAE monitor.
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5.5.4 Configuring All Settings

A user can use this function to update the entire
configuration settings (except the instrument ID, serial
number and the datalog option) in the MultiRAE monitor.
To configure all the settings in the instrument, click the
Option->Config All menu item, and a message box will
appear to remind the user to connect the instrument to the
PC through the serial port.  After making sure that the
instrument is connected to the PC, click the OK button.
Another message box will appear to warn the user that this
operation will erase all the current configuration settings in
the monitor.  If the user does not want this to happen, click
the Cancel button, otherwise click the OK button to start
the data transfer.

After the information is sent successfully, a message box
will appear to indicate that the sending configuration
process is completed.  Click the OK button to close the
message box.

Warning:  The Config All option is mainly used to restore
the MultiRAE monitor’s default operational settings when
the configuration of the unit is non-recoverable and the unit
is malfunctioning.  Because the default parameters are not
normally fit a specific unit, a user will need to re-
calibration, re-setup lamp, pump, and LCD contrast
threshold, etc.  Try not to use this function if possible.
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5.6 Processing the Logged Data

The ProRAE-Suite software allows the user to retrieve the
logged data from the MultiRAE PLUS monitor and display
the data in many different formats.  The user can also
export the displayed text to a tab delimited text file so that
Microsoft Excel can read it directly.
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5.6.1 Receive Data from MultiRAE PLUS

To receive the logged data from the MultiRAE Plus, click
Communication->Receive Data menu item or click the
Receive Data toolbar button (left arrow with “Recv”
letters), a message box will appear to remind the user to
connect the instrument to the PC through the serial port.
After making sure the instrument is connected to the PC,
click the OK button to start the data transfer.  After the data
transfer is finished, a new client window is opened with the
newly received logged data displayed.  In order to save the
logged data for future use, the user can click File->Save or
File->Save As menu item to save the newly received
logged data to a file.
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5.6.2 View Logged Data in Text Mode

Once the user opened a data file or received the logged
data from the instrument, a data window appears, as shown
in Figure 5-10.

Figure 5-10   Display Logged Data

The data window is a two pane client window. The left
pane is a tree view which lists all the display format of
each event, and the right pane displays the information
according to the display format and the event the user
selected on the left pane. To select any display format of
any event, the user can simply click the format item on the
left pane.  To view the next event or the previous event, the
user can click the Next Event (double right arrow) or the
Previous Event (double left arrow) toolbar buttons.  The
user can also drag the splitter bar between the left pane and
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the right pane to the left or to the right to enlarge a pane if
that pane is not big enough.

To view the data points of a specific event, the user can
click the item representing that event under the item
Data\Text Mode.  For example, click the item Event #1
on the left pane, the right pane displays the data points of
Event #1, as shown in Figure 5-10.
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5.6.3 View STEL/TWA/AVG Value

To view the STEL, TWA or AVG value of any event, click
the event number item under the tree item
STEL/TWA/AVG in the left pane, the right pane displays
the STEL, TWA and AVG value of each data points of that
event, as shown in Figure 5-11.

Figure 5-11   STEL/TWA/AVG of the Logged Data
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5.6.4 View Summary Information

To view the summary information of any event, such as
peak data value and minimum data value, click the event
number item under the tree item Summary in the left pane,
the right pane displays the summary information of that
event, as shown in Figure 5-12.

Figure 5-12   Summary Information of the Logged Data
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5.6.5 View Logged Data in Graph Mode

To view the logged data of a specific event in graph mode,
click the event item under the tree item Graph Mode in the
left pane, and the right pane displays the graph of that
event, as shown in Figure 5-13.

Figure 5-13   Graph of the Logged Data

Select graph type:
The user can choose the type of sensor data in the Graph
Type tab page of the Graph Settings dialog box. To
display the Graph Settings dialog box, click any place in
the right pane so that pane has the focus, then click
Option->Graph Settings menu item to display the Graph
Settings dialog box.  Figure 5-14 shows the Graph Type
tab page of the Graph Settings dialog box.  Here the user
can choose which sensor data to be shown on the graph,
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whether to show a grid on the right pane, and the title of
the graph.

Figure 5-14   Graph Type Tab Page

Select graph range:
The user can choose the value range on the x-axis and y-
axis in the Graph Range tab page of the Graph Settings
dialog box.  To display the Graph Settings dialog box,
click any place in the right pane so that pane has the focus,
then click Option->Graph Settings menu item to display
the Graph Settings dialog box.  To bring the Graph
Range tab page, the user can simply click the page header
of the Graph Range tab page.  Figure 5-15 shows the
Graph Range tab page of the Graph Settings dialog box.
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This is the place where the user can choose the graph range
on the x-axis and y-axis.

Figure 5-15   Graph Range Tab Page

To choose the range of Y-axis, the user first click the User
Defined radio button in the Y-Axis (Data Value) Range
group box, then the user can specify the top value and the
bottom value in the Data Value Range (Y-axis) group
box.

If the user select the Default radio button in the Y-Axis
(Data Value) Range group box, the ProRAE-Suite
software will scale the range of Y-axis by itself to cover
the maximum data value on y-axis.
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To choose the range of X-axis, the user first click the User
Defined radio button in the X-Axis (Data Time) Range
group box, then specify the start time fields in the Start
Time (X-axis) group box and the end time fields in the
End Time (X-axis) group box.

If the user select the Default radio button in the X-Axis
(Data Time) Range group box, the ProRAE-Suite will
scale the range of X-axis by itself to cover the every data
points on x-axis.
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5.6.6 Export the Displayed Data to a Text File

The ProRAE-Suite software allows the user to export the
displayed text to a tab delimited text file so that it can be
read by Microsoft Excel directly.  To export the text
displayed in the right pane to a tab delimited text file, click
Option -> Export Text menu item, a Save As dialog box
is displayed.  Specify the file name in the File name field,
then click the OK button to close the Save As dialog box.
A new file is created that can be read by Microsoft Excel

directly.  Appendix C shows a detailed step by step
instruction on how to export data as text file and use
Microsoft Excel to open the text file.
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5.6.7  Export Graphics to a File

The ProRAE-Suite software allows the user to export the
displayed graph to a windows bitmap (.bmp) file or a
windows metafile (.wmf) file.  To export the displayed
graph in the right pane to a windows bitmap or metafile
file, first click any place in the right pane to make sure that
the graph pane has the focus, then click Option -> Export
Graph menu item to display a Save As dialog box. Select
the export graph file type (.bmp or .wmf) in the Save as
type field, then specify the export file name in the File
name field.  Click OK button to close the Save As dialog
box. The newly created graph file contains the graph
displayed in the right pane.
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5.6.8  Print the Logged Data
After viewing the data results, the user may print the data
to a printer in order to obtain a hard copy of the text or
graphic data report.  First, click any place in the right pane
to set the focus on that pane, then select Print function
from the File sub-menu, or click the Print toolbar button
(a printer) to print the graphic or text data.

A printer setup dialog box will appear before the printing
starts so that the paper size, orientation, printer type, etc.
can be configured correctly.
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5.7 Upgrade the Datalog Option

To upgrade the datalog option, open the ProRAE-Suite
software.  Do not open any configuration file or data file so
the ProRAE-Suite software has no client window open, as
shown in Figure 5-16.

Figure 5-16   Main Window of ProRAE-Suite

Click Option -> Enable Datalog menu item, a message
box will appear to remind the user to connect the
instrument to the PC through the serial port.  After making
sure that the MultiRAE PLUS monitor is connected to the
PC, click the OK button to start.  After the ProRAE-Suite
software made successful contact to the instrument
connected to the PC, a dialog box is displayed, as shown on
Figure 5-17.
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Figure 5-17   Enable Datalog Dialog Box

Figure 5-17 shows that the instrument’s datalog feature is
currently enabled. If the user wants to change the datalog
option, click another datalog option radio button, and type
the three digit authorization code in the Authorization
Code field, then click the OK button to close the dialog
box. After the datalog option is changed, a message box
will appear on the screen to let the user know that the
datalog option is successfully changed.

Note:  Each MultiRAE PLUS with datalogging function
should be shipped with a 3 digit authorization code.  If the
code is missing, call the factory’s Customer Service
Department to obtain one.
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5.8 Upgrade the Firmware
To upgrade the firmware in the MultiRAE PLUS monitor,
open the ProRAE-Suite software.  Do not open any
configuration file or data file so the ProRAE-Suite
software has no client window open, as shown in Figure 5-
16. Click Option -> Load Firmware menu item, a
message box will appear to remind the user to connect the
instrument to the PC through the serial port.  After making
sure that the instrument is connected to the PC, click the
OK button.  After the ProRAE-Suite software made
successful contact to the instrument connected to the PC,
an Open file dialog box is displayed, as shown on Figure
5-18.  Select the firmware file (.a07) which is going to be
loaded into the instrument, click the OK button to start the
loading process. After the firmware loading is finished, a
message box will appear on the screen to let the user know
that the firmware is successfully loaded into the instrument.
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Figure 5-18   Open Firmware File Dialog Box

Note:  In order to upgrade the firmware, the MultiRAE
PLUS monitor must have a 2.04 or later version of the
firmware.  Call the factory’s Customer Service
Department, if the existing firmware version is older than
2.04 for instruction on how to upgrade the firmware.
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6. THEORY OF OPERATION

The MultiRAE PLUS monitor uses one to five different
sensors to measure a variety of gases.  A newly developed
electrodeless discharge UV lamp is used as the high energy
photon source for the PID sensor (see Figure 6-1).  The
patented PID sensor will detect a broad range of organic
vapors.  Up to two electrochemical toxic gas sensors can be
installed in the monitor to measure inorganic toxic gases.
Many different types of toxic sensors are offered.  They
can be plugged into these two sensor sockets and are
interchangeable.  A catalytic bead sensor is used to
measure combustible gases.  An electrochemical sensor is
used to measure oxygen.

Figure 6-1   Block Diagram of MultiRAE PLUS Monitor
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The PID sensor for this MultiRAE PLUS monitor is
constructed as a small cavity in front of the UV lamp.  The
other sensors are mounted next to the PID sensor.  A
diaphragm pump is installed inside the monitor to draw the
air sample into the sensor manifold and then distribute it to
all sensors.

A single chip microcomputer is used to control the
operation of the alarm buzzer, LED, pump and light sensor.
It measures the sensor readings and calculates the gas
concentrations based on calibration to known standard
gases.  The data are stored in non-volatile memory so that
they can be sent to a PC for record keeping.  RS-232
transceivers provide a serial interface between the monitor
and the serial port of a PC.  A 2-line by 16-character LCD
display is used to show the readings.  The user interacts
with the monitor through three keys on the front panel
keypad.

A rechargeable Li-ion or Ni-Cd battery or a set of four
disposable AA alkaline batteries powers the monitor.

NOTE:  The printed circuit board is connected to the
battery pack even if the power is turned off.  Therefore,
it is very important to disconnect the battery pack
before servicing or replacing sensors or any
components inside the monitor.  Severe damage to the
printed circuit board may occur if the battery pack is
not disconnected before servicing the unit.   
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7. MAINTENANCE

As shown in Figure 7-1, the major maintenance items of
MultiRAE PLUS are:

• Battery pack
• Sensor modules
• PID lamp
• Sampling pump

Figure 7-1  Main Components of MultiRAE PLUS
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7.1 Battery Replacement

When the display shows a flashing message “Bat”, the
battery requires recharging.  The battery may be replaced in
the field  (in area known to be non-hazardous) if required.
It is recommended to recharge the MultiRAE PLUS
monitor upon returning from field work.  A fully charged
battery powers a MultiRAE PLUS monitor for 10 hours
continuous operation.  The charging time is less than 10
hours for a fully discharged battery.  The built-in charging
circuit is controlled by two-step constant voltage / constant
current charging to prevent over-charging.

WARNING:

To reduce the risk of ignition of hazardous
atmospheres, recharge battery only in area known
to be non-hazardous.  Remove and replace
battery only in area known to be non-hazardous.
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Replacing and Recharging Battery Pack
1. Turn off power of the MultiRAE PLUS.
2. Refer to Figure 7-1, unscrew the two captured case

screws from the bottom of the monitor case and remove
the MultiRAE PLUS cover.

3. Unplug the battery from the battery jack, which is
connected to the PC board of the MultiRAE PLUS.

4. Connect the battery pack to the DC jack on an external
charging station (optional) for charging.

5. Replace a fully charged spare battery pack in the
MultiRAE PLUS.

6. Ensure the battery plug is securely connected to the
MultiRAE PLUS.

7. Close the MultiRAE PLUS cover and tighten the
screws.

Replacing Alkaline Battery Adapter
1. Insert four fresh AA size alkaline batteries into the

alkaline battery adapter.  Make sure that the polarity of
the battery is correct.

2. Follow the same procedure as described above to
replace the battery adapter.

Note:  The internal charging circuit is designed to prevent
charging to alkaline batteries when alkaline batteries are
installed inside the monitor.
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7.2 Sensor Replacement

The toxic, combustible and oxygen sensors all have
limited expected operating lives.  Under normal operating
condition, most sensors will lose their original sensitivity
after the expected operating life and will need to be
replaced.

Each sensor module in MultiRAE PLUS includes a non-
volatile memory, which records the manufacturing date of
the sensor.  In the diagnostic mode, the microprocessor will
check the date code and display the expiration date of each
sensor.  It is suggested that the user should replace the
sensor when the current date exceeds the expiration date of
a sensor.

Sensor Replacement Procedure
The oxygen and combustible sensor each has their unique
sensor sockets in the MultiRAE PLUS monitor.  The
two toxic sensor sockets in the MultiRAE PLUS
monitor allow users to plug in any two sensors selected
from the series of toxic sensors offered by RAE Systems
Inc.

1. Turn off power of the MultiRAE PLUS.

2. Refer to Figure 7-1, open the monitor cover by
unscrewing the two captured screws from the bottom of
the monitor case.  Disconnect the battery pack.
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Figure 7-2   Sensor Assembly of MultiRAE PLUS

3. Refer to Figure 7-2, carefully unscrew four No. 2
screws that hold down the gas piping plate to the analog
PCB and sensors.  Remove the gas piping plate.

4.  Refer to Figure 7-2, identify the location of a specific
toxic sensor and remove the sensor by gently pulling
the sensor upward.
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5.  Plug a new sensor into the empty sensor socket.  Make
sure that black line on the sensor label is lined up with
the white marker on the PCB and the sensor pins are
aligned with the socket before pushing down the sensor.

6. Replace the gas piping plate and tighten the four screws
to hold down the sensors.  Re-connect the battery pack.
Replace the monitor cover.

7. Turn on the power of the MultiRAE PLUS. The
microprocessor will automatically recognize the sensors
installed and configure the monitor accordingly.

Special Bias Voltage for Toxic Sensors:
The NO and NH3 toxic sensors require a special 300 mV
bias voltage to operate.  Only the Tox1 sensor position
provides such a special bias voltage.  Therefore, the NO or
NH3 toxic sensor must be plugged into the Tox1 sensor
socket in MultiRAE PLUS. In addition, there is a dip
switch or pin jumper located on the analog PCB next to the
PID sensor.  When biased toxic sensor is plugged into the
Tox1 position, it is necessary to turn the dip switch or
move the jumper to the “ON” position to enable the bias
voltage.  During power on sequence, the microprocessor
will check the sensor ID and the bias voltage.  If the NO or
NH3 sensor is plugged into the wrong toxic sensor socket
or the bias voltage is not switched on, an error message
will be displayed.
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7.3 PID Sensor Cleaning / Replacement

This section only applies to a monitor that is equipped with
the PID detector option.  During the course of normal
operation, a film of gas vapor may build up inside the PID
sensor module and the UV lamp.  The rate at which the
film develops depends on the type and concentration of the
vapors being sampled.  As a guide, it is recommended to
clean the PID sensor module and lamp only when the PID
is malfunctioning.

The sensor module is made of several components and is
attached to the lamp housing unit as shown in Figure 7-2.
If the lamp does not turn on, the monitor will display an
error message of “Lamp” to indicate cleaning or replacing
of the lamp is required.  Periodic cleaning of the lamp
window will also remove film deposits and restore lamp
sensitivity.  Care must be exercised when cleaning
the window surface so that it will not be damaged.

1. Turn off power of Multi-gas Monitor.

2. Refer to Figure 7-1, open the monitor cover by
unscrewing the two case screws from the bottom of the
monitor case.  Disconnect the battery pack.

3. Refer to Figure 7-2, carefully unscrew four No. 2
screws that hold down the gas piping plate to the analog
PCB and sensors.  Remove the gas piping plate.
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4. Remove the shielding cap for the PID sensor.  Gently
pull out the PID sensor.  Note the sensor is made of
Teflon and stainless steel material.

5. Dip the entire PID sensor into GC grade methanol.  It is
highly recommended that an ultrasound bath to be used
to clean the sensor for at least 3 minutes.  Then dry the
sensor thoroughly.

6. If the lamp is operational, use a cotton swab to clean the
flat window surface with GC grade methanol.  If the
lamp does not turn on remove the UV lamp.

7. Install a new lamp, avoiding contact with the flat
window surface.

8. Reinstall the PID sensor.  Install the shielding cap.

9. Refer to Figure 7-2, install the gas piping plate and
tighten the four screws to hold down the sensors.  Re-
connect the battery pack.  Install the monitor cover.
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7.4  PID Lamp Care

The UV lamp is made of a glass envelope and a UV
window on one end of the envelope.  The inside of the
lamp is filled with low pressure gases.  To turn on the
lamp, a high voltage electric field is applied from the
outside of the glass envelope.  The molecules inside the
lamp are ionized and produce a glow discharge to generate
the UV light.  Because this UV lamp does not have an
electrode inside the glass envelope, it requires only a small
amount of ions inside the lamp to initiate the glow
discharge process.

If the UV lamp has not been used for a long period of time
(> 1 month), it may be slightly harder to turn on.  If such a
condition occurs, an error message “Lamp” will appear in
the monitor display during the power on sequence.  This
phenomenon is more significant in 0.25” UV lamps used in
MultiRAE Plus products, because of the relatively small
lamp size.

To solve this problem, simply turn on and off the monitor a
few times and the lamp should turn on.  Gently shaking the
monitor will also help to initiate the glow discharge
process.  After the UV lamp is turned on for the first time,
it should be easier to turn on the UV lamp next time.
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The MultiRAE Plus has a built-in sensing mechanism to
monitor the status of the UV lamp.  If the UV lamp is not
on, the error message “Lamp” will be displayed.  It is
possible that the UV lamp is actually on when the lamp
error message appears.  When the UV lamp becomes old,
changed, or the configuration file in side the MultiRAE has
been totally over-written, the threshold level to determine
lamp failure may be wrong and cause a false alarm. To
eliminate such a possibility, simply apply some VOC by
putting a felt-tip marker close to the inlet of the MultiRAE
and see if the VOC raw count goes up.  If the UV lamp is
on while the error message persists, then it is necessary to
adjust the lamp threshold.  Please refer to Chapter 8 on
adjusting the threshold level for the UV lamp.

If chemical liquid or dust has been sucked into the unit,
clean the lamp window surface by wiping it with
anhydrous methanol using a cotton swab.  Rub in a circular
motion at moderate pressure.  After cleaning, hold the lamp
up to the light at an angle to detect any remaining film.
Repeat the process until the lamp window is clean.

Never touch the window surface with fingers or
anything that may leave a film.

(CAUTION:  Water will degrade window surfaces,
especially the 11.7 eV lamp window)
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7.5  Sampling Pump Replacement

The sampling pump is positive displacement piston pump.
When approaching the end of the specified life time of the
pump, it will consume higher amount of energy and reduce
its sample draw capability significantly.  When this occurs,
it is necessary to replace the pump.

1. Turn off power of Multi-gas Monitor.

2. Refer to Figure 7-2, open the monitor cover, disconnect
the battery pack, carefully unscrew four No. 2 screws
that hold down the gas piping plate to the analog PCB
and sensors.  Remove the gas piping plate.

3. Carefully loosen the connector. Unscrew the two
screws that hold the pump assembly to the gas plate.
(For older model, use a soldering iron to de-solder the
two wires that connect the pump to the PCB.  Unscrew
the two screws that holding the pump to the PCB.)
Disconnect the Tygon tubing that connects the pump to
the gas inlet port.

4. Replace a new pump assembly.  Connect the Tygon
tubing to the gas inlet port.  Solder the pump wire and
screw down the pump assembly to the analog PCB.

5. Refer to Figure. 7-2, replace the gas piping plate and
tighten the four screws to hold down the sensors.  Re-
connect the battery pack.  Replace the monitor cover.
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8. TROUBLESHOOTING

To aid the user in diagnosing the monitor, the monitor has
a special diagnostic mode that can display critical, low
level parameters.  Section 8.1 describes the operation of the
diagnostic mode.  Section 8.2 summarizes the frequently
encountered problems and suggested solutions.  Turning on
the MultiRAE PLUS monitor in diagnostic mode and
using the troubleshooting table in Section 8.2, the user can
usually narrow the problem down to one or two areas and
correct the problem without having to return the monitor
for repair.

WARNING:  The diagnostic mode allows the user to set
several low level parameters which are very critical to
the operation of the monitor.  Extra care should be
taken when setting these low level parameters.  If the
user are not familiar with these parameters and set
them incorrectly, it may cause the monitor to shut
down or malfunction.  The diagnostic mode should be
used by qualified personnel only.
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8.1 Special Diagnostic Mode

To place the monitor into the special diagnostic mode, first
turn the monitor off.  Next push and hold the [Y/+] key,
while still holding the [Y/+] key, also push and hold the
[MODE] key for at least two seconds.  After the required
delay, release both keys, the monitor will now go through
the normal start-up display sequence and display a
“Diagnostic mode” message.  At the end of the special
mode start-up, the display will show 1 to 5 numbers with a
message “Raw.”  These numbers are raw sensor readings
without calibration.

Other critical parameters of the monitor are available as
shown in Table 8.1.  They can be reached by pressing the
[MODE] key repeatedly until the desired parameters are
displayed.



TROUBLESHOOTING

8 - 3

Table 8.1
Key Action Display

Show raw readings
[MODE] Show sensor name
[MODE] Adjust PID lamp failure threshold
[MODE] Show battery type and Tox1 bias
[MODE] Show x1 and x10 range of PID

sensor
[MODE] Adjust LCD contrast
[MODE] Check LEL power on/off
[MODE] Show clock, battery voltage and

temperature
[MODE] Show LEL & OXY sensor

expiration date
[MODE] Show TOX1 & TOX2 sensor

expiration date
[MODE] Adjust pump stall  threshold
[MODE] Adjust back light on/off threshold
[MODE] Show serial number and toggle

pump speed
[MODE] Begin battery deep discharge
[MODE] Show battery duration time
[MODE] Communicate with PC?

Note:  The 3rd and 5th display only apply to the monitor
which is equipped with PID detector option.

Here is a brief description of each diagnostic display and
how to interpret the displayed values:
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1) Raw Sensor Readings
The raw sensor readings provide a quick diagnose on the
response and the sensitivity of each sensor.  When zero gas
(fresh clean air) is applied to the monitor, the raw sensor
readings typically should be between 200 to 700 for toxic
and VOC sensors, between 100 to 1300 for  LEL sensor
and between 1200 to 2300 for oxygen sensor.  If the raw
reading is outside these ranges when zero gas is applied,
the sensor or the electronics may be defective.

When a specific gas is applied to the monitor, the
corresponding sensor should respond and the raw reading
should increase or decrease.  If the reading of the
corresponding sensor does not change when the specific
gas is applied, then the sensor may be defective.

TOX1               VOC TOX2

  365      360  373
  530     RAW      1879

LEL      OXY

2) Sensor Name
All the toxic, oxygen and LEL sensors have a non-volatile
memory which contains the sensor identification and other
vital information, such as manufacturing date, expected
operating life, etc.  If a sensor is programmed and installed
properly in the monitor, the sensor name should be
displayed.  If the sensor name does not show up in the
display, then the sensor may not be programmed properly
or may be defective.
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3) Adjust Lamp Failure Threshold
This diagnostic menu only applies to the monitor which is
equipped with a PID detector option.  This display can be
used to calibrate the PID lamp failure threshold.  If the
lamp appears to be good but in normal operation a lamp
failure message (i.e. “Lamp”) is displayed, the lamp failure
level may be set too high.  This level can be adjusted by
using the following steps:
1. Turn the monitor off.
2. Remove the UV lamp of the PID sensor, then replace

the sensor and cover.
3. Turn on the monitor in the special diagnostic mode.
4. Press the [MODE] key until “Lamp = xxx, Fail = yyy

+/-” is display.  The reading “xxx” is the lamp current
reading when the lamp is off.  The value “yyy” is the
threshold value which determines when does the lamp
fail.

5. Push the [Y/+] or [N/-] key to increase or decrease the
threshold value “yyy” until it is about 10 counts above
the “xxx” value.  This will optimally set the lamp
failure threshold.  Press [MODE] key to exit this
display.  If the threshold value is changed, a message
“Save new lamp threshold?” will appear.  Press [Y/+]
to confirm the change, [N/-] or [MODE] key to
abandon the changes.

6. Turn the monitor off and replace the lamp.
7. Turn on the monitor in diagnostic mode again and press

the [MODE] key until “Lamp = xxx, Fail = yyy +/-” is
display.  This time, the reading “xxx” is the lamp
current reading when the lamp is on and it should be
higher than the threshold value “yyy” by at least 15-20
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counts.  If not, the lamp may be defective or very weak.
In most cases lamp failure threshold adjust is not required,
in which case the user should press [MODE] key to exit this
display.

4) Battery Type and Bias Display
For some toxic sensors (such as nitric oxide or ammonia
sensor), a bias voltage of a few hundred millivolts is
required for the sensor to function properly.  In the
MultiRAE PLUS monitor, the user needs to manually
switch on the bias voltage supply located on the analog
PCB (see Section 7.2 for details).  This may alternately be
a jumper, where the jumper position should follow the
board marking – On or Off.  For this test to work, a nitric
oxide or ammonia sensor has to be installed in the toxic #1
socket.  If the bias voltage is switched to ON position, the
bias reading should be below 182, otherwise the bias
supply may be defective.

The MultiRAE PLUS monitor can be powered by either a
rechargeable Ni-Cd battery pack or an alkaline battery
adapter.  This display also shows the type of battery which
is installed inside the monitor.

5) Show x1 and x10 Range of PID Sensor
This diagnostic menu only applies to the monitor which is
equipped with a PID detector option.  The PID sensor
output is connected to two amplifiers with two different
gains:  Unity gain and gain of ten.  Raw outputs of both
amplifiers are displayed.  When zero gas is applied, both
amplifier output should be between 200 to 500.  When a
VOC gas is applied, both amplifier output should increase
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and the amount of increase for the unity gain (x1) amplifier
should be about 1/10 of the increase for the gain of ten
(x10) amplifier.  If the increase does not agree with
expected value, then the gain switch of the amplifier may
be defective.

6) Adjust LCD Contrast
This display allows the user to adjust the LCD contrast.
Press [Y/+] to increase the contrast and [N/-] key to
decrease the contrast.  The bar graph shows the current
LCD contrast setting.  If the display appears having dark
lines, press [Y/-] key several times should see a more clear
display.

7) Check LEL Power ON/OFF
This display shows the present condition of the LEL sensor
power and raw reading.  The top display shows the
instantaneous reading of raw counts from the LEL sensor.
The bottom line shows if the LEL sensor is powered.  By
pressing [N/-] key the power can be turned off.  The [Y/+]
key turns powers to the LEL on.

8) Show Clock, Battery, and Temperature
This display shows the real time clock, battery voltage in
raw count and temperature sensor reading.

9) Sensor Expiration Date
This display shows the expiration date (month and year) of
all the installed sensors in the MultiRAE PLUS monitor.
The expiration date is calculated based on the
manufacturing date and expected life of each sensor which
were stored inside each sensor when it was fabricated in
the factory.  If the current date exceeds the expiration date
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of any sensor, the performance of the given sensor can no
longer be guaranteed.  It is strongly recommended that the
user replace the sensor immediately to ensure proper
operation of the sensor.

10) Adjust Pump Stall Threshold
This display can be used to calibrate the pump stall
threshold.  If the gas inlet is blocked but the pump does not
shut down, or the pump shut down too easily with a slight
blockage to the gas inlet, then the pump stall threshold
value may be set too high or too low.  Use the following
steps to adjust the pump stall threshold.

1. The maximum and average pump current is displayed on
the first row:  “Pump = xxx/zzz.”  The current pump
stall value is displayed on the second row: “Stall = yyy
+/-.”  The typical maximum pump current without any
blockage should be between 20 – 35 when the speed is
set to be “low” and the water trap filter is installed.  The
typical stall value should be higher than the “un-
blocked” pump current by at least 5-8 counts.

2. The user can block the gas inlet for about ten seconds
and watch the pump current reading. The stall threshold
should set to be the average of the idle reading and the
block reading.  That is: Stall = (Idle + Block) / 2.  The
readings to be used in the calculation are maximum
pump current readings at the “xxx” location of the unit.

3. Use [Y/+] or [N/-] key to increase or decrease the stall
value until it is the average of the idle reading and the
block reading.  Press [MODE] key to exit this display.
If the threshold value is changed, a message “Save new
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stall threshold?” will appear.  Press [Y/+] to confirm
the change, [N/-] or [MODE] key to abandon the
changes.

4. The pump stall threshold should be re-adjusted if the
pump speed is switched to “low” or “high,” or water
trap filter changed, or the firmware configuration has
been totally refreshed.

11) Check Back Light Threshold
This display can be used to adjust the LCD back light turn
on and off threshold.  Verify that the threshold is 100
which will fit almost all of the situation.

12) Serial Number and Pump Toggle
This display shows the unit’s serial number. If a pump is
installed and pump speed control circuit available, the
display “Pump=Low/(High)” may be toggled by pressing
the [N/-] key.  Note that changes made here are only for
testing the pump condition and do not become saved in the
nonvolatile memory (see Section 4.7 to update the pump
speed setting).

13) Display Battery Duration Time
This display shows the run time of the last time the unit
powered itself off due to a low battery.  It is useful for
battery life testing.

14) Communicate with PC?
This display give the option of communicate with the PC
for upload or download activity.
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8.2 Troubleshooting Table

Table 8.2
Problem Possible Reasons & Solutions
Cannot turn
on power
after
charging the
battery

Reasons: Discharged battery.
Defective battery.
Microcomputer hang-up.

Solutions: Charge or replace battery.
Disconnect then connect
battery to reset computer.

No LED or
LCD back
light

Reasons: Defective LED or LCD back
light.

Solutions: Call authorized service
center.

Lost
password

Solutions: Ask the service center for
help.

Buzzer
inoperative

Reasons: Bad buzzer.

Solutions: Call authorized service
center.
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Problem Possible Reasons & Solutions
Reading
abnormally
high

Reasons: Wrong calibration data.
Dirty sensor module.
Dirty water trap filter.
Excessive moisture and
water condensation.

Solutions: Re-calibrate with the gas.
Clean sensor module.
Replace water trap filter.
Blow dry the sensor module.

“Lamp”
message
during
operation

Reasons: Wrong threshold.
Dirty PID sensor.
Weak or defective PID lamp.

Solutions: Adjust the lamp threshold.
Clean PID sensor.
Replace PID lamp.

Reading
abnormally
low

Reasons: Incorrect calibration.
                      Low sensitivity to the

specific gas.

Solutions: Calibrate the monitor.
                      Replace sensor.
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Problem Possible Reasons & Solutions
Read a
small
background
value when
there is no
detectable
gas.

Reasons: Sensor zero drifted.
The unit was out of battery
power connection or the
sensor just plugged in.

Solutions: Do fresh air calibration (see
Section 4.4.1)
Wait for reading to
stabilized.

Reading
jumping
around
randomly

Reasons: Incorrect gas calibration.
Low sensitivity to cal gas.

Solutions: Calibrate the sensor.
                      Use different cal gas.

Cannot turn
off monitor
or corrupted
characters
in LCD
display

Reasons: Microprocessor hang-up.

Solutions: Disconnect and re-connect
battery to reset computer.
Call authorized service
center.

Calibration
error
message

Reasons: No standard gas input.
Solutions: Make sure standard gas

flows into monitor.
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Problem Possible Reasons & Solutions
“Bat”
message in
operation

Reasons: Discharged battery.

Solutions: Recharge battery.

“Voltage
too high
message” in
charge
mode

Reasons: Battery fuse blown or wrong.
                     AC adapter or AC adapter

does not fully plug in.

Solutions: Check battery and adapter.
Detach and plug in the
adapter again.

Full scale
measure-
ment in
humid
environment

Reasons: Dirty or wet sensor.

Solutions: Clean and dry sensor.
Replace water trap filter.

VOC
Measureme
nt max out
at certain
level

Reasons: Dirty PID sensor module.
Weak PID lamp.

Solutions: Clean lamp / sensor module.
Replace new lamp.

                      Replace filter.

Excessive
pump noise
or no inlet
air vacuum

Reasons: Leaky inlet path.
                    Defective pump.

Solutions: Check inlet connection.
                      Replace a new pump.



APPENDIX A

A-1

APPENDIX A.  QUICK REFERENCE GUIDE

                      DISPLAY MODE
Display Instantaneous Readings

[N]+[MODE] for 3 seconds:
Security level=0 or Display Mode: No Action
Security level=1 or Text Mode: Password check

Wrong password: Back to instantaneous display
Correct password: Enter Programming menu.

[N]: Toggle back light [Y]: Test alarm/stop alarm
[M]
 Display Sensor names  
[M]
 Display Peak values
[M]
 Display Minimum values  
[M]
 Display STEL values
[M]
 Display TWA values  
[M]
 Display Battery voltage
[M]
 Display Clock / Run time / Internal temperature
[M]
Configured for Manual datalog?   

yes: Start/Stop Datalog?
[Y]: Start or Stop Datalog
[M]: Go to “Display LEL gas name”

no: Display Datalog mode
[M]
 Display LEL gas name (if sensor is present)
[M]
 Display VOC gas name (if sensor is present)
[M]
 Communicate with PC?

[Y]: Monitor will pause OK?
[Y]: Ready...
[N]: Return to Instantaneous display

[M] or [N]
 Return to Instantaneous display
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PROGRAMMING MODE
Press [N] and [MODE] together for 3 seconds to enter, [Mode] to return

 Calibrate Monitor? (Press [Y] to select menu)
  Fresh Air Calibration?
  Multiple Sensor Calibration?
  Single Sensor Calibration?
  Modify Span Gas Value?
  Change LEL/VOC Span Gas?

 Change Alarm Limits?
 Change High Alarm limit?
 Change Low Alarm limit?
 Change STEL alarm limit?
 Change Average alarm limit?

View or Change Datalog?
 Reset Peak and Minimum?
 Clear All Data?
 Change Datalog Period?
 Select Data Type?
 View Datalog?
 Enable/Disable Datalog?

Change Monitor Setup?
 Change Site ID?
 Change User ID?
 Change Alarm Mode?
 Change User Mode?
 Change Real Time Clock?
 Change Backlight Mode?
 Change Password?
 Change Pump Speed?
 Change Averaging Method?

Change Sensor Configuration?
 Change LEL/VOC Gas Selection?
 Enable / Disable Sensor?
 Change Dilution Ratio?
 Change PID Lamp Type?

N

Y

Mode

Mode

Y

N

Y

Mode
N

Mode

Y

N

N
Y

Mode

N

N

N

N

N
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APPENDIX B.  CORRECTION FACTORS

A partial list of correction factors for a number of
commonly used compounds for the LEL sensor, 10.6 eV
and 11.7 eV PID sensors is as follows (refer to TN-106
and TN-156 at www.raesystems.com for complete lists
of correction factors):

Table B.1
Correction Factors for PID & LEL Sensors

Compound 10.6 11.7 LEL
Acetaldehyde 5.5 3.3 1.8
Acetic acid 22 2.6 3.4
Acetone 1.1 1.4 2.6
Acrylic acid 12 2.0
Acrylonitrile NR* 1.2
Allyl alcohol 2.4 1.7
Ammonia 9.7 5.7 0.79
Benzene 0.53 0.6 2.1
Butadiene 0.85 2.5
Butane, n- 67 2.0
Butyl acetate, n- 2.6
Butyl acrylate, n- 1.6 0.6
Carbon disulfide 1.2 4
Carbon monoxide NR NR 1.2
Chlorine NR 1.0
Cyclohexane 1.4 0.64 2.5
Cyclohexanone 0.9 0.7
Dichloroethane, 1,2- NR 0.6
Dichloroethene, t-1,2- 0.45 0.34
Dichloromethane NR 0.9 1.0
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Compound 10.6 11.7 LEL
Diesel Fuel 0.7 0.4
Diethylamine 0.97
Dimethylhydrazine, 1,1- 0.78 0.83
Epichlorohydrin 0.85 1.4
Ethanol 12 1.7
Ethene 10 1.5
Ethyl acetate 4.6 2.2
Ethyl acrylate 2.4 1.0
Ethyl benzene 0.52 0.51 2.8
Ethyl ether 1.1 2.3
Ethyl hexyl acrylate, 2- 1.1 0.48
Ethyl sulfide 0.51
Gasoline vapors 0.85
Gasoline, whole 1.0 0.47 2.1
Heptane, n- 2.8 0.6 2.4
Hexamethyldisilazane 0.24 0.19
Hexane, n- 4.3 0.54 2.3
Hydrazine 2.6 2.1
Hydrogen NR NR 1.2
Hydrogen sulfide 3.3 1.5 2.3
Isobutane 100 1.2 1.8
Isobutene 1.00 1.00 1.7
Isobutyl acrylate 1.5 0.60
Isopropanol 6.0 1.6
Jet fuel JP-4 1.0 0.42
Jet fuel JP-5 0.6 0.46
Jet fuel JP-8 0.6 0.32
Methane NR NR 1.0
Methanol NR 2.5 1.5
Methyl acrylate 3.7 1.2
Methyl ethyl ketone 0.86 1.1 1.7
Methyl isobutyl ketone 0.80 0.60
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Compound 10.6 11.7 LEL
Methyl methacrylate 1.5 1.2
Methyl t-butyl ether 0.91
Nitric oxide 5.2 2.8
Octane, n- 1.8 2.9
Pentane ~80 8.4 1.8
Perchloroethene 0.57 0.31
Pinene, a- 0.31 0.47
Pinene, b- 0.37 0.37
Propane NR 1.6 1.5
Propene 1.4 1.6 1.5
Styrene 0.40 0.4
Tetrahydrofuran 1.7 1.0
Toluene 0.50 0.51 1.9
Trichloroethane, 1,1,1- NR 0.98
Trichloroethene 0.54 0.43
Vinyl chloride 2.0 0.64 1.8
Xylene, m- 0.43 0.40 2.7
Xylene, o- 0.59 0.69 3.0
Xylene, p- 0.45 0.62 2.8
* NR = No Response.  Blank space = no data
For more data see Technical Notes 106 (PID) and 156 (LEL)

The VOC correction factors in Table B.1 are measured relative
to isobutylene gas and LEL correction factors are measured
relative to methane gas.  All measurements are at <5% relative
humidity and 25oC, typically at 50-100 ppm for VOC and 20-
80% LEL for LEL. The factors may change at higher
concentration or different temperature and humidity conditions.
The factors are to be multiplied by the reading to obtain the
actual concentration or % LEL of the gas.  If the correction
factor of a gas is <1.0, then the sensitivity to the gas is higher
than that of isobutylene (VOC) or methane (LEL).
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APPENDIX C.   MULTIRAE PLUS DATA
CONVERSION TO MICROSOFT
EXCEL

The MultiRAE PLUS multi-gas monitor has a built-in 20,000
point datalogger that in conjunction with the ProRAE-Suite
software will provide data that can be converted into other
application program such as  Microsoft Excel (Version 7.0) for
further data manipulation or graphing.

To convert the data file into Excel, and to facilitate easier data
manipulation, the follow these procedures:

1. Export the event data to a tab delimited text file, as
described in Section 5.6.6:  Export the displayed data to a
text file.  Assume we have just export the event data to a file
called TextEvent.txt in C:.  To convert that file to a MS-
Excel file, open the MS-Excel software, as shown in Figure
C-1.

Figure C-1   Excel Window
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2. Click File->Open menu item to open the Open dialog box,
select the folder where the file TextEvent.txt is resided, and
select the Files of type as Text Files.  Click to select the file
TextEvent.txt, as shown in Figure C-2.

Figure C-2   Open Dialog Box

3. Click OK button, a Text Import Wizard dialog box is
open, as shown in Figure C-3.

Figure C-3   Text Import Wizard Dialog Box
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4. Click Finish button, the dialog box disappears and the event
data is loaded into the MS-Excel software, as shown in
Figure C-4.

Figure C-4   File Text Event.txt is Open

5. Click File->Save As menu item to save the loaded event
data to a MS-Excel file.  Ensure that in the Save As dialog
box, the Save as type is Microsoft Excel Workbook.

Graphing MultiRAE PLUS Data in Excel

1. Open the Excel data file that contains the data to be
graphed by selecting “File” and then “Open.”  Highlight the
columns that contain the data points.  Make sure that the
header information is not highlighted.

2. Go to the “Insert” menu, and under “chart” elect “As New
Sheet.”
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3. The first step of the ChartWizard will appear.  In the
“Range” area, the cells that were highlighted on the chart
will be denoted.

              

 Press the “Next” button to continue.

4. The next step will show the different chart types.  For this
example, the “Line” chart has been selected.
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 Press the “Next” button to continue.

5. Step 3 of the ChartWizard give additional choices for
the line chart, including data markers and gridlines.  In
this example, number 4 has been selected, so there will
be markers and gridlines.

              

 Press the “Next” button to continue.

6. The next step shows a preview of the chart.  This will
ensure that the correct columns were chosen in the
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spreadsheet that comprise the chart.  Press the “Next”
button to continue.

7. The final step is where the chart title and axis titles may
be added. After these are added in the spaces provided,
press the “Finish” button.

8. A sample of a finished chart is below.  For additional
information and other modifications that can be made to
the Excel chart, please refer to the Excel instruction
manual.
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